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Foreword
This foreword contains information on the ImageXpress® Ultra Confocal 
High Content Screening System User Guide and the text conventions 
used. It also includes important safety information. 

Purpose of this Manual
This User Guide details the technical features and specifications of the 
ImageXpress® Ultra System instrument and software. It also provides 
installation, configuration, maintenance and troubleshooting 
procedures. To operate the ImageXpress Ultra System, only follow the 
procedures in this User Guide. Using procedures other than those 
specified within this guide can result in hazardous conditions or injury 
or damage to the instrument.

Conventions
Make sure that you follow the precautionary statements presented in 
this guide. The conventions used in this guide are:

CAUTION! Indicates that damage to the instrument, loss of data, or 
individual injury could occur if the user fails to comply with the advice 
given.

WARNING! Indicates a possibility of severe or fatal injury to 
the user or other persons if the precautions are not observed.

Note: Emphasizes significant information in a procedure or description.

Tip! Provides useful information or shortcuts, but the information is 
not essential to complete a procedure.
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Foreword
Safety Information
Before using or servicing the ImageXpress Ultra System, you must be 
familiar with the operation and potential hazards of the instrument. You 
should read, understand, and obey all safety precautions. Failure to 
follow these safety precautions could result in serious personal injury or 
damage to the instrument. Warnings in this document and labels on the 
instrument use international symbols. 
The operator of the ImageXpress Ultra System must be trained in the 
correct operation of the instrument and in the safety procedures. 
Making adjustments or performing procedures other than those 
specified in this guide might result in hazardous exposure to laser light, 
high voltage, hot surfaces or moving parts. Exposure to these hazards 
can cause severe or fatal injury.

Note: These safety practices are intended to supplement your national 
and local health and safety regulations and laws. The information 
provided covers instrument-related safety regarding the operation of 
the instrument. The information does not cover every safety procedure 
that should be practised. Ultimately, you and your organization are 
responsible for compliance with national and local EHS (Environmental 
Health and Safety) legal requirements and for maintaining a safe 
laboratory environment.
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Safety Labels
If the safety label on the instrument becomes illegible or is missing for 
any reason, contact Technical Support for a free replacement label. 
While waiting for a replacement label, copy the label below and attach a 
copy of the label to the instrument. 
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Foreword
The following safety label appears on the power supply.
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Warning Labels
Table F-1 displays the safety symbols used on the ImageXpress® Ultra 
System and in this User Guide.

Protective Housing
The protective outer housing and instrument panel interlocks are 
designed to protect you from exposure to laser light, high voltage, hot 
surfaces or moving parts. 

TableF-1 Warning Labels

Safety 
Symbol Description Safety 

Symbol Description

Electric Shock Hazard Warning

Laser Hazard Toxic Chemical Hazard

Lifting Hazard Puncture Hazard

WARNING! Do not defeat the interlocks, open the protective 
housing, or try to gain access to the interior of the instrument 
through any other openings, unless specifically instructed by 
one of the user procedures outlined in this manual. Read each 
procedure carefully and follow all outlined safety precautions. 
Incorrectly opening the outer protective housing can damage 
the instrument components and result in hazardous exposure 
to laser light, high voltage, hot surfaces or moving parts. 
0112-0149 F 13 



Foreword
Interlock Failure 
There are three safety interlocks on the automated (top) door. Do not 
operate this instrument with the door open.

The interlocks have failed if the focus lasers, scanning lasers, or PMTs 
(photomultiplier tubes) remain on after the automated (top) door is 
opened.
It is unsafe to continue using the ImageXpress® Ultra System under 
these conditions. Contact Molecular Devices Technical Support 
immediately.

Non-interlocked Panels
There are several other panels on the instrument that are intended for 
use by field service personnel and are not interlocked. All non-
interlocked service panels are secured to the protective housing with 
screws that require a special tool to remove. 

Laser Safety Information
For safe laser operation:

• The system must be installed and serviced by an Molecular 
Devices FSE (field service engineer). 

• All instrument panels must be in place on the instrument while 
the instrument is operating. 

• Do not remove safety labels or disable safety interlocks.
With interlocks in place, the ImageXpress Ultra System is a Class 1 
laser device. There are multiple Class 3b lasers embedded within the 
unit, which the user cannot and should not attempt to access. Table F-2 
displays the embedded laser classification and power.

WARNING! Do not disable any of the interlocks. When the 
automated (top) door is opened, the interlocks trigger both the 
laser light source and the motion control electronics to turn off 
to prevent hazards associated with laser emission or moving 
parts. 

WARNING!  Make sure the instrument is powered off and the 
power cable is unplugged if you are instructed to remove non-
interlocked panels. Do not operate or access the interior of this 
instrument with any covers or panels removed.
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During normal operation, you can safely place samples in the loading 
area without exposure to laser power levels above Class 1. 

TableF-2 Embedded Laser Classification and Power

Nominal 
Wavelength

Typical 
Power

Maximum 
Laser 
Power

Duration Embedded 
Laser Class

405 nm 20 mW 200 mW Continuous 
Wave

Class 3b

488 nm 15 mW 150 mW Continuous 
Wave

Class 3b

532 nm 20 mW 300 mW Continuous 
Wave

Class 3b

561 nm 15 mW 300 mW Continuous 
Wave

Class 3b

635 nm 20 mW 100 mW Continuous 
Wave

Class 3b

690 nm 20 mW 100 mW Continuous 
Wave

Class 3b

WARNING! LASER HAZARD. Maintenance and servicing of the 
lasers must only be done by Molecular Devices trained 
personnel. Invisible Class 3b laser radiation is accessible with 
the covers removed and the interlocks defeated. Approved 
safety eye protection must be worn. Eye protection must be 
rated for use with the emitted wavelength.

WARNING! OCULAR HAZARD. Never look directly into the laser 
beam. Do not remove the instrument panels. Lasers can burn 
the retina causing permanent eye injury or blindness.

WARNING! BURN HAZARD. Do not operate the lasers when 
they cannot be cooled by the cooling fan. An overheated laser 
can cause severe burns if it comes into contact with the skin. 
Always wear laser safety goggles appropriate for the emitted 
wavelength.
0112-0149 F 15 



Foreword
High-Voltage Hazard
There are no user-accessible high-voltage electronics found inside the 
ImageXpress Ultra System. Do not attempt to open or service the 
instrument, apart from through the sample loading door, while the 
system is powered on. Do not attempt to open or service the power 
supply at any point.

Moving Parts
The ImageXpress® Ultra System contains moving parts that can cause 
injury. Under normal conditions, the instrument is designed to protect 
you from these moving parts. The interlocks and protective housing are 
designed so you cannot access the moving parts during a scan.

Fuses
The instrument power supply contains a circuit-breaker switch with a 
trip point of 18.75 amps.

Power Supply
The instrument has two cables running from the instrument to the 
external power supply (input voltage range is from 100 to 240 VAC, 
50/60 Hz, 2 A). 

WARNING! Do not try to gain access to the interior of the 
instrument unless specifically instructed to do so. The moving 
parts inside the instrument can cause injury. Do not operate 
this instrument with covers or panels removed.

WARNING! Make sure the power supply cable is unplugged 
before accessing any part of the instrument. Failure to do so 
can result in serious harm.
16 0112-0149 F 



ImageXpress Ultra Confocal High Content Screening System User Guide
Lifting Hazard

CAUTION! Moving your instrument can disrupt sensitive optical 
alignments. Contact Technical Support to schedule an FSE (field service 
engineer) to help with moving your instrument. Your warranty or 
service contract will not cover problems caused during or as a result of 
shipment or relocation.

Maintenance and Service
User service and maintenance is strictly limited to the procedures 
outlined in this manual. The majority of serviceable components are 
accessed through the interlocked panels described above and as such 
must be accessed by a Molecular Devices FSE. If there is a problem or 
you have questions, contact Molecular Devices Technical Support.

Hazardous Material Precautions
Use standard laboratory procedures and cautions when working with 
chemicals.

WARNING! Do not attempt to lift or move the instrument 
without assistance. The instrument weighs approximately 
220 pounds (100 kg). 

WARNING! Always follow the manufacturer’s precautions 
when working with chemicals. Molecular Devices is not 
responsible or liable for any damages caused by, or as a 
consequence of, the use of any hazardous material.
0112-0149 F 17 
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Obtaining Support
Part of effective communication with Molecular Devices is determining 
the channels of support for the ImageXpress Ultra System, including 
the MetaXpress® High Content Image Acquisition and Analysis 
Software. Molecular Devices provides a wide range of support:

1. Documentation — Check the manuals that are included on the 
installation media and the help that is available within the 
MetaXpress Software. Help for an active dialog box can be 
accessed by pressing the [F1] key. 

2. Online knowledge base — The knowledge base has links to 
technical notes, software upgrades, newsletters, manuals, and 
other resources. Visit the Molecular Devices Support web page 
at www.moleculardevices.com/support and follow the links to 
the knowledge base. 

3. Technical Support — 
Phone: Contact Technical Support at (800)-635-5577 (U.S. 
only) or +1 408-747-1700. 
Online: Visit www.moleculardevices.com/support and follow the 
links in the knowledge base to the Technical Support Request 
Form to send an e-mail to a group of experienced Technical 
Support representatives. 
Please have the system ID number, system serial number, 
software version number, and the system owner’s name 
available when you call.

To find your system ID number, from the Help menu, select 
About MetaXpress. The dialog that appears displays your 
system ID number. 
The system serial number is located on your instrument.

4. Additional support resources include:
Nikon web-based microscopy course — 
http://www.microscopyu.com 
The Molecular Probes handbook — 
http://www.probes.invitrogen.com offers advice on 
fluorescent probes and can help you determine if there are 
better stains available for your analysis.

The following sites offer filter information:
http://www.chroma.com
http://www.semrock.com
http://www.omegafilters.com
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1
Introduction
ImageXpress Ultra System Overview
The ImageXpress® Ultra Confocal High Content Screening System is an 
integrated high throughput confocal cellular imaging and analysis 
system that is designed for rapid, automated screening of fluorescently 
labeled biological samples in microplates. The ImageXpress Ultra 
system consists of:

• Imaging instrument
• MetaXpress® High Content Image Acquisition and Analysis 

Software
The core hardware component of the imaging system is a 
custom-designed, fully automated, point-scanning confocal microscope, 
with rapid autofocus and precision sample movements. With the 
ImageXpress Ultra System, you can acquire large numbers of 
high-resolution images in the shortest possible time. All key optical and 
mechanical elements are motorized, with asynchronous command 
execution, thereby allowing complete real-time control of the 
instrument configuration through the MetaXpress Software interface.
When used with the powerful imaging capabilities of the MetaXpress 
Software, the instrument becomes an extremely flexible and 
programmable device, ideally suited for user-defined high-speed 
automated assays. Key features of the instrument include:

• Two to four solid-state lasers for efficient, specific sample 
illumination from 405 nm to 635 nm

• Four photomultiplier tubes (PMTs) for simultaneous or 
sequential multiwavelength scanning

• Fast laser autofocus system with a precision motorized Z (focus) 
stage, dedicated 690 nm laser, and fast optical sensor

• User-adjustable detection pinhole
• Precision motorized X-Y (sample) stage
• High-quality user-changeable Nikon objectives in a four-position 

linear selector. The first position must be occupied by the 10X 
Plan Fluor objective which is used for system calibration and can 
be used for imaging.

• User-changeable emission filter sets in a three-position slider
• Selectable averaging to increase the signal-to-noise ratio of the 

images
• User-configurable scan length for variable sized images
• Five self-aligning main beam splitters that users can select in 

the MetaXpress Software
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• Operation and configuration by integrated MetaXpress Software
• Plate-handling robot (optional) with automated barcode reader

System Installation
The ImageXpress Ultra System is shipped fully configured, and is 
installed at your site by a Molecular Devices FSE (field service 
engineer). The base system includes the imaging unit, host computer, 
and toolkit.
Make sure that the power cord from the ImageXpress Ultra System 
power supply is connected to a 100 VAC to 240 VAC power source. The 
ImageXpress Ultra System host computer is shipped with the 
MetaXpress Software already installed, and the instrument is connected 
to the power supply host computer during installation. 
There are four main connections, excluding power cords:

• Two power supply cables to the instrument
For the lasers
For all other components

• Two USB 2.0 data cables between the instrument and the 
acquisition computer

For device control
For image acquisition and transfer 
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2
Quick Start Guide
This chapter describes how to turn on the ImageXpress® Ultra System 
and log in to the MetaXpress® Software. All procedures assume that the 
ImageXpress Ultra System has been installed and configured by an 
Molecular Devices FSE (field service engineer). 
The following topics are included in this chapter:

• Turning on the ImageXpress Ultra System on page 21
• Starting the Software on page 22
• Logging AxoTrace Messages to a .txt File on page 23
• Setting up and Running Plate Acquisition on page 25
• Turning off the ImageXpress Ultra System on page 25

Turning on the ImageXpress Ultra System

To turn on the ImageXpress Ultra System

1. Turn on the power switch on the front of the ImageXpress Ultra 
System power supply control box. 

2. Turn on the power switch on the computer.
3. Turn on the power switch on the LCD monitor.
4. After the computer has started and Windows is running, log in to 

Windows using the user name and password provided by your 
system administrator.

CAUTION! Do not log in to your system as Guest unless you are 
specifically instructed to do so by your system administrator. Many 
functions require administrator-level privileges to operate correctly.
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Starting the Software

To start the MetaXpress Software application

1. Click Start > Programs > MetaXpress > MetaXpress. 
2. If you are required to select a user name before the Welcome to 

MetaXpress dialog is displayed then you are in multi-user mode, 
and you must select a user name and then click OK to continue.

3. In the Welcome to MetaXpress dialog, in the Data Source list, 
select the data source to connect to.

4. In the Login Name and Password fields, type the name and 
password, and then click OK. 
For versions 4.0 and 5.0 of the MetaXpress Software, the default 
User Login Name is MolDev, the default System Administrator 
Login Name is sa, and the default password for both is moldev. 
For earlier versions of the software, the default User Login Name 
and password was mdc. You might need to log in using mdc if 
you had an earlier version of the software on your instrument 
workstation. If needed, you can change the password by clicking 
Change Password. 
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5. In the Group dialog, select one of the groups that your particular 
login has been assigned to and click OK. 
The MetaXpress Software starts and initializes the various 
components of the ImageXpress Ultra System. If you receive 
error messages when the system is initializing, make sure that 
all hardware connections are plugged in and fully seated. Close 
the software, turn off the instrument, wait for 10 seconds, turn 
on the instrument, and open the software.

Logging AxoTrace Messages to a .txt File
AxoTrace tracks the hardware status of the ImageXpress Ultra System 
and logs all the hardware activities of the system. If the error occurs 
downstream of the initial cause, AxoTrace provides a log that Molecular 
Devices Technical Support can use to trace the error back to the 
original cause and pinpoint the problem. Use the procedure below if a 
reproducible hardware error occurs. Follow the AxoTrace setup 
procedure and record the steps that lead to the error. If the error 
results in the instrument not starting up, not responding, or the error 
cannot be reproduced, contact Molecular Devices Technical Support 
immediately.

To log AxoTrace messages to a .txt file

1. Open the MetaXpress Software and AxoTrace starts 
automatically.
The AxoTrace icon appears in the toolbar.

2. Close the MetaXpress Software.
3. Double-click the AxoTrace icon in the toolbar.

Note: If hardware errors persist, contact Molecular Devices 
Technical Support and make sure you provide: the serial 
number of the instrument, the MetaXpress Software version 
(see the Help in the software), MetaXpress ID (on the 
MetaXpress dongle or see the Help in the software), screenshot 
of any error message, and the saved AxoTrace output.
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4. In the AxoTrace window, click Options > Output to File and make 
sure that the Time prefix option is selected.

5. Click File > Save As and in the Save As dialog that appears, in the 
Name field, navigate to the location where you want to save the 
log file, type the file name (for example, axotrace log.txt) and 
then click Save to save the log file.

6. Close the AxoTrace dialog and then start the MetaXpress 
Software.

7. Reproduce the error and after the error is reproduced, close the 
MetaXpress Software. 

8. Send the AxoTrace log as an e-mail attachment to Molecular 
Devices Technical Support.
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Setting up and Running Plate Acquisition
This procedure assumes that the ImageXpress Ultra System and the 
MetaXpress High Content Image Acquisition and Analysis Software 
have been properly installed and configured by the Molecular Devices 
FSE and your system administrator. 

To set up and run plate acquisitions

1. Turn on the ImageXpress Ultra System and start the MetaXpress 
Software.

2. Click Screening > Plate Acquisition Setup.
3. In the Plate Acquisition Setup dialog, complete each tab with the 

appropriate settings for your experiment, working from the top 
tab to the bottom tab. See Setting Up Plate Acquisition on 
page 79.

4. After you have completed the information in all the tabs and are 
on the final Summary tab, click Acquire Plate to acquire a plate of 
images using the settings.

Turning off the ImageXpress Ultra System

To turn off the ImageXpress Ultra System 

1. Close the MetaXpress Software. You will be prompted to save 
any open images.

2. Click Start > Shutdown > Shutdown to shut down the computer.
3. Turn off the power switch on the LCD monitor.
4. Turn off the power switch on the front of the ImageXpress Ultra 

System power supply control box.
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3
Imaging System Overview
This chapter provides information on imaging systems. The following 
topics are included:

• Fluorescence Imaging on page 27
• Confocal Imaging on page 28
• Electronics on page 29
• Imaging Optics on page 29
• Objective (Z) Stage on page 37
• Sample X-Y Stage on page 38
• Autofocus Laser on page 38

Fluorescence Imaging
Fluorescence is a phenomenon observed in certain species of molecules 
(fluorochromes, or dyes) in which photons of a specific wavelength are 
absorbed (excitation), and as a result a very short time later photons 
are emitted at a longer wavelength (emission). The use of fluorescence 
imaging in biological applications stems from the ability to conjugate 
fluorescent molecules with biologically active probe molecules, so that 
the application of the combined dye/probe molecule (fluorophore) to 
the specimen highlights the specific substances or regions to which the 
probe is targeted. 
By attaching different probes to a set of dye molecules with different 
excitation and emission spectra, you can stain a specimen with multiple 
fluorophores, and either simultaneously or sequentially image different 
structures or substances within the same specimen. Usually sequential 
imaging is required when the excitation and emission spectra of 
selected fluorophores are significantly overlapped. The absorption and 
emission peaks for each dye in a given environment are physical 
characteristics of that molecule, and their specific properties determine 
the initial selection of the optical components to be used, for example, 
excitation lasers, emission filters, and beam splitter.
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Confocal Imaging
In standard wide-field microscopy, fluorescent objects above or below 
the focal plane are seen as out-of-focus objects and increase the 
background fluorescence. Confocal microscopy rejects out-of-plane 
signals by using point-source illumination and a pinhole aperture ahead 
of the detector. 
A confocal microscope is neither more sensitive nor faster than a 
wide-field microscope. The main advantage of confocal imaging is the 
rejection of unwanted signal and the resulting improved resolution and 
reduced background. By changing the size of the pinhole in front of the 
detector you can achieve a suitable balance between the degree of 
confocality and the sensitivity and speed of the instrument. A smaller 
pinhole gives better axial resolution, while a larger pinhole increases 
the collection efficiency resulting in higher sensitivity. 
Figure 3-1 Schematic of the ImageXpress Ultra System shows the 
internal components of the system. 

Figure 3-1 Schematic of the ImageXpress Ultra System
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Electronics
The ImageXpress Ultra System includes:

• External power supply with two DC cables
• USB 2.0 port and cable to computer for device control
• USB 2.0 port and cable to computer for image transfer

Imaging Optics
This section provides information on components of imaging optic 
systems.

• Excitation Lasers on page 29
• Beam Combiners on page 30
• Beam Expander on page 30
• Galvanometer on page 30
• Relay Lens on page 31
• Main Beam Splitter on page 31
• Objective Lenses on page 32
• Tube Lens on page 32
• Motorized Iris on page 33
• Emission Filters on page 33

Excitation Lasers
In the ImageXpress Ultra System the sample is illuminated by any 
combination of up to four pre-installed solid-state excitation lasers. 
These lasers have variable power output, controllable through the 
MetaXpress Software. Shutters protect samples from laser illumination 
while not in use. The lasers have a minimum expected lifetime of 5000 
hours.
You can configure the system to use one laser at a time (sequential 
scanning), a combination of lasers (simultaneous scanning), or a 
combination of sequential and simultaneous scanning. For example, 
you can complete an initial scan with the 405 nm laser only and then do 
a second scan with the 488 nm and 635 nm lasers simultaneously. 
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A combination of the following five lasers might be included in your 
ImageXpress Ultra System. 

• 405 nm (optional)
• 488 nm (standard)
• 532 nm (optional)
• 561 nm (optional)
• 635 nm (standard)

Beam Combiners
Beam combiners are used to combine the illumination light provided by 
the excitation lasers that are required for simultaneous imaging of 
multiple channels. 

Beam Expander
The ImageXpress Ultra System achieves its best resolution when the 
entire pupil of the objective is used for emission and excitation. The 1x, 
2x, and 3x beam expanders in the system have dual purpose: 

• Expansion of the excitation beam diameter
• Contraction of the emission beam diameter

Because of the beam expanders, the ImageXpress Ultra System can 
work with various types of objectives with the greatest possible 
efficiency.

Galvanometer
A mirror reflecting light at a variable angle is a key component of many 
scanning microscopes. The mirror delivers the excitation light to a 
specified point on the sample. The fluorescent signal acquired at 
different positions of the mirror is reconstructed by the software into a 
fluorescent image of the sample. In the ImageXpress Ultra System, the 
motion of the galvanometer provides data for the X-axis (horizontal) of 
the image.
The ImageXpress Ultra System uses a state of the art galvanometer as 
a variable angle mirror. An optimal combination of mirror size, flatness, 
rigidity, and operating speed guarantees the best resolution and image 
acquisition rate. 

Note: Either the 532 or 561 nm laser (but not both) can be installed in 
the instrument. 
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Relay Lens
The relay lens is a complex optical system that redirects the angularly 
scanning excitation laser beam (scanned by the galvanometer) into the 
objective pupil while keeping the beam centered in the pupil.

Main Beam Splitter
One of the five pre-installed beam splitters separates the excitation and 
the emission pathways in the ImageXpress Ultra System. All five are 
mounted on a precision-motorized wheel that is controlled by the 
MetaXpress Software. When a beam splitter is selected, the main beam 
splitter wheel self-aligns for optimal image conditions. This precision 
self-alignment can take as long as 15 seconds. Only one beam splitter 
per experiment can be selected to maintain high-speed image 
acquisition.
The main beam splitter reflects excitation light and transmits emission 
light. The following five beam splitters are included in the standard 
configuration of the ImageXpress Ultra System:

• 80/20 neutral density (80% transmission efficiency, 20% 
reflection)

• 405/488/532/635 quad notch
• 90/10 neutral density (90% transmission efficiency, 10% 

reflection)
• 488/635 dual notch
• 405/488/561/635 quad notch

Both beam splitter 80/20 and 90/10 are neutral density separators. 
They deliver only 20% or 10% respectively, of the incident laser light to 
the sample, and 80% or 90% of the fluorescent light to the detector 
but with no limitation on the spectrum of the fluorescent light. The 
main disadvantage of neutral density separators is that a significant 
portion of the laser light reflected from the sample is mixed with 
fluorescent light and is delivered to the detector. You must take special 
precautions to block this reflected light, requiring sophisticated 
emission filters. See Emission Filters on page 33.
The other beam splitters produce spectral separation. Each three digit 
number in the filter name denotes the central wavelength of the narrow 
band (approximately 10 to 15 nm) of light being reflected by the beam 
splitter. For example, the 488/635 dual notch beam splitter reflects 
488 ±5 nm and 635 ±5 nm light to the sample and at the same time 
transmits other wavelengths from the sample to the detector.
Spectral separation beam splitters deliver nearly 100% of laser light to 
the sample and collect fluorescent light with nearly 100% efficiency, 
except in those wavelength ranges knocked out by notches. In addition, 
these notches greatly diminish the presence of laser light reflected from 
the sample in the fluorescent light delivered to the detector.
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In the MetaXpress Software, you cannot select lasers that are 
incompatible with the selected beam splitter. For example, the 532 nm 
laser option is unavailable if either the 488/635 dual notch or 
405/488/561/635 quad notch is selected.

Objective Lenses
The selected objective lens focuses excitation light on to the sample, 
and collects fluorescence light emitted by the sample. Objectives are 
classified according to the optical correction, flatness of field, numerical 
aperture, and working distance. Before choosing additional objectives 
to use with the system, it is important to consider the types of plates 
that you are imaging. The plate material (plastic or glass) and plate 
thickness are major considerations when choosing an objective. You 
can configure the ImageXpress Ultra System with a large number of 
high-quality standard Nikon objectives from the CF160 series. 
Molecular Devices offers a wide range of objectives to suit your 
experimental needs. For a complete list of objectives, see Appendix A: 
Objectives Compatible with the ImageXpress Ultra System on 
page 173.
The 10X Plan Fluor objective is standard on all ImageXpress Ultra 
Systems. It is installed in position 1 of the objective changer and must 
never be removed from this position. The position 1 placement of this 
objective is critical for galvanometer calibration and laser autofocus 
configuration. This objective is also available for standard imaging. 
Certain objectives have adjustable spherical-aberration correction 
collars for imaging through thick substrates such as the plastic or glass 
bottom of most microplates. For details on how to adjust them, see 
Adjusting the Spherical-Aberration Correction Collar on Objectives on 
page 165.

Tube Lens
The relay lens and beam expander reduce the diameter of the 
collimated light from the objective by a factor of 3 to 9 times, 
depending on the beam expander selected. The tube lens focuses the 
reduced diameter collimated beam onto the aperture (iris) in front of 
the detector. The combined effect of these components is to collect the 
in-focus fluorescence signal while rejecting the out-of-focus 
(non-collimated) fluorescence signal. 

Note: Setting these correction collars is critical for the optimization of 
the image quality.
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Motorized Iris
In confocal imaging, the diameter of the iris (pinhole) determines the 
amount of out-of-focus fluorescent light that reaches the detector. 
Increasing the iris diameter allows more signal (higher sensitivity) but 
decreases the degree of confocality. 
In the ImageXpress Ultra System, the iris is motorized, and its 
diameter can be changed from 1 mm to 8 mm using the MetaXpress 
Software.

Emission Filters
In the ImageXpress Ultra System, the emission filters are located in 
sets of filter cubes. 
When imaging the illuminated sample, you must collect emission 
photons only from the target fluorophore, rejecting reflected or 
scattered excitation light, any light from other dyes, and 
autofluorescence from the sample and substrate. This is accomplished 
by placing a filter in the emission path called the emission filter. In the 
ImageXpress Ultra System, the emission filters have an additional role 
of separating out the signal from multiple fluorophores and delivering 
them to separate PMTs.
The ImageXpress Ultra System uses custom-designed Semrock filters. 
It contains three rack positions and each rack contains a position for 
three Nikon TE2000 cubes. The emission filter in front of the PMT filters 
the light to that PMT. Emission filter cubes can either be bandpass, for 
maximum specificity, or longpass to maximize the amount of emission 
light collected.

Note: While standard Nikon TE2000 cubes are used, the component 
positioning within these cubes is not the same as in an epifluorescence 
microscope.
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Figure 3-2 Comparison of ImageXpress Ultra System and Epifluorescent 
filter cubes
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Typical ImageXpress Ultra System Filter Cube 
Configurations
The figures below show the typical configurations for the filter cubes 
and their position in the ImageXpress Ultra System.

Figure 3-3 Standard Filter Set Configuration
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Figure 3-4 532 Filter Set Configuration
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Figure 3-5 561 Filter Set Configuration

Photomultiplier Tubes
In the ImageXpress Ultra System, the PMTs (photomultiplier tubes) are 
used as the photodetectors. The standard configuration uses four PMTs 
and the PMT gain is individually controlled by the PMT voltage.

Objective (Z) Stage

Motorized Z Stage
The Z stage position is measured by a precision linear encoder and has 
better than 100 nm resolution. 

Motorized Objective Changer
The ImageXpress Ultra System has a four-position objective changer 
allowing you to select the required objective using the software. Only 
the selected objective will be moved by the motorized Z stage.
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Sample X-Y Stage

Sample
The plate holder is designed for scanning multiwell plastic and 
glass-bottom microplates in standard ANSI (SBS) 1-2004 through ANSI 
(SBS) 4-2004 formats, but can accommodate other plate formats that 
have standard microplate footprint dimensions. For example, glass 
slides can be imaged using a slide adapter included in the tool kit. 
Optimal image quality depends on plate flatness and optical clarity.

Plate Holder and Plate Clamp 
A spring-loaded mechanical clamp holds the sample plate securely in 
the plate holder. The clamp automatically opens when the X-Y stage 
moves to the load/unload position, and automatically closes when the 
X-Y stage moves the plate into position for imaging. The ImageXpress 
Ultra System is configured so that the A1 position is placed next to the 
plate clamp, although this can be reversed if required.

Motorized X-Y Stage
The X-Y stage position is measured by precision linear encoders and 
has better than 100 nm resolution. The X-Y stage controls the position 
of the sample plate above the optical path. In addition, in the 
ImageXpress Ultra System, the Y-stage provides the motion required 
for the Y-axis (vertical) scan direction of the imaging.

Autofocus Laser
A red (690 nm) diode laser projects a beam on to the sample plate. 
Reflections of this laser beam from the bottom of the microplate and 
from the plate–sample interface are imaged by a dedicated, fast 
camera. The ImageXpress Ultra System uses these reflections to 
autofocus as the sample plate moves from well to well.
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Post-Installation and Testing
After the installation of the ImageXpress® Ultra System is complete, 
the system is ready for initial testing and use. 
This chapter includes the following topics:

• Verifying device settings in the Meta Imaging Series® 

Administrator
X-Y stage
Objectives
Filter cube sets

• Verifying camera settings in the Meta Imaging Series 
Administrator

• Verifying settings in the MetaXpress® Software
Magnification settings
Calibration settings
Laser autofocus sensor
Plate settings
Shading correction files

Verifying Device Settings in the Meta Imaging Series 
Administrator

You must check that the ImageXpress Ultra System components are 
properly configured using the Meta Imaging Series Administrator 
software and the MetaXpress Software. All hardware and software 
configuration settings are implemented in the Meta Imaging Series 
Administrator software. You cannot run the Meta Imaging Series 
Administrator and the MetaXpress Software at the same time.

Tip! For additional information on any of the dialogs in the Meta 
Imaging Series Administrator, press the F1 key to access Help. 
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Before using the ImageXpress Ultra System, you must verify the device 
settings for the hardware components:

• To verify the ImageXpress Ultra System X, Y, and Z settings on 
page 40

• To verify the objective settings on page 44
• To verify the beam expander settings on page 46
• To verify the pinhole settings on page 46
• To verify the filter cube settings on page 47
• To verify the beam splitter settings on page 49

To verify the ImageXpress Ultra System X, Y, and Z 
settings

1. Turn on the ImageXpress Ultra System but do not start the 
MetaXpress Software. See Turning on the ImageXpress Ultra 
System on page 21.

2. Click Start > Programs > MetaXpress > Meta Imaging Series 
Administrator.

3. In the Meta Imaging Series Administrator dialog, in the List of 
Groups field, select MetaXpress and then click Configure 
Hardware. There is a 30 to 45 second delay while the system 
initializes the components.

CAUTION! It is critical that the ImageXpress Ultra System is powered on 
before clicking Configure Hardware. Failure to do so can result in the 
loss of critical system settings. If Configure Hardware is selected with 
the system turned off, do not click OK. Use Cancel to avoid losing the 
critical system settings.

Tip! For additional information on any of the dialogs in the Meta 
Imaging Series Administrator, press the F1 key to access the 
Help for the active dialog. This includes accessing information 
on the single-user and multi-user modes.
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4. In the Configure Hardware dialog, click Configure Devices. 
5. In the User Settings for Default hardware configuration dialog that 

appears, in the Claimed Devices field, select ImageXpress Ultra X 
and then click Settings.
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6. In the ImageXpress Ultra X Settings dialog, in the Device Units 
field, verify that the value is 50 and that the Reverse Coordinate 
System check box is clear.

7. In the Position Settings section, in the Move field, type 10000 to 
increase the step size. 

8. In the Move field, click the  icon and confirm by sound that 
the stage responds to the control. Verify that the X-stage 
position has been updated and that no error messages appear.

9. Click OK.
10. In the User Settings for hardware configuration dialog that appears, 

in the Claimed Devices field, click ImageXpress Ultra Y and then 
click Settings.

11. In the ImageXpress Ultra Y Settings dialog, in the Device Units 
field, verify that the value is -50 and that the Reverse Coordinate 
System check box is selected.
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.

12. In the Position Settings section, in the Move field, type 10000 to 
increase the step size.

13. Click the  icon and confirm by sound that the stage responds 
to the control and also verify that the Y-stage position has been 
updated and that no error messages appear.

14. Click OK and then in the User Settings for hardware configuration 
dialog that appears, in the Claimed Devices field, click 
ImageXpress Ultra Z and then click Settings.

15. In the ImageXpress Ultra Z Settings dialog, in the Device Units 
field, verify that the value is 50.

16. In the Position Settings section, in the Move field, type 1000 to 
increase the step size.

17. Click the  icon and confirm by sound that the Z Motor 
responds to the control and also verify that the Z-stage position 
has been updated and that no error messages appear. 

18. Lower the Z Motor to 0 µm and then click OK. 

Note: Do not exceed a Z position of 5000 µm during this 
verification procedure.
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To verify the objective settings

1. In the User Settings for hardware configuration dialog, in the 
Claimed Devices field, select ImageXpress Ultra Objective and then 
click Settings. 

2. In the ImageXpress Ultra Objective Settings dialog, confirm that 
the objectives in the Objective fields, and the values in the Num. 
Aperture fields match each objective on your system.

Note: The first character of each objective label name must be 
its numerical magnification value. If there is no objective in that 
position, use a number at the beginning, for example, 4-Empty. 
The NA (numerical aperture) values are written on each 
objective. See Table A-1 Nikon Objectives Compatible with the 
ImageXpress Ultra System on page 173 for the NA value for 
each objective.

Note: The 10X Plan Fluor objective must always be in position 
#1. This objective must be in this position for the system to 
perform calibration prior to plate acquisition.
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3. In the Objective Parameters section, click the Param Group #1 
tab. This tab contains the Z offset positions in microns for the 
objectives. Confirm that these are valid numbers and all but one 
is greater than 0.
See Configuring Objective Offsets and Parfocality on page 145 
to determine the offset values.

4. Click the Param Group #2 tab and then click Open Control Dialog. 
5. In the Control – ImageXpress Ultra Objective dialog, click the 

arrow buttons and confirm by sound that the objective changer 
is moving and also verify that the objective position has been 
updated and that no error messages appear.

6. Click Done and then click OK to close the Objective Settings 
dialog.
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To verify the beam expander settings

1. In the User Settings for hardware configuration dialog, in the 
Claimed Devices field, select ImageXpress Beam Expander and 
then click Settings.

2. In the ImageXpress Ultra Beam Expander Settings dialog, confirm 
that the positions listed in the Position Labels section are correct.

3. Click Open Control Dialog and in the ImageXpress Ultra Beam 
Expander Settings dialog, click the arrow buttons to confirm that 
the beam expander changer is responding to the program by 
verifying that the beam expander positions have been updated 
and that no error messages appear.

4. Click Done and then in the ImageXpress Ultra Beam Expander 
Settings dialog click OK to close it.

To verify the pinhole settings

1. In the User Settings for hardware configuration dialog, in the 
Claimed Devices field, select ImageXpress Pinhole and then click 
Settings.

2. In the ImageXpress Ultra Pinhole Settings dialog, verify that the 
value in the Device Units field is 10.
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To verify the filter cube settings

1. In the User Settings for hardware configuration dialog, in the 
Claimed Devices field, select ImageXpress Filter Cube and then 
click Settings.
0112-0149 F 47 



Post-Installation and Testing
2. In the Position Labels section, confirm that the Position fields 
match the filter cubes on your system.

3. In the Discrete Component Parameters section, click Open Control 
Dialog. 

4. In the Control – ImageXpress Filter Cube dialog, click the arrow 
buttons and confirm by sound that the filter cubes are 
responding to the program and also verify that the emission 
filter set position has been verified and no error messages 
appear. 

5. Click Done and then in the ImageXpress Ultra Filter Cube Settings 
dialog, click OK to close it.

Note: The format for the filter names is 
Wavelength1;Wavelength2; Wavelength3;Wavelength4. 

Each entry must be separated by a semicolon. If a filter cube is 
missing from any filter cube assemblies, leave it blank between 
the semicolons.

WARNING! Ambient light will damage the PMTs. Do not 
open the filter cube access door while the system is 
powered on.
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To verify the beam splitter settings

1. In the User Settings for hardware configuration dialog, in the 
Claimed Devices field, select ImageXpress Beam Splitter and then 
click Settings.

2. In the ImageXpress Ultra Beam Splitter Settings dialog, confirm 
that the positions listed in the Position Labels field are correct.

3. In the Discrete Component Parameters section, click Open Control 
Dialog.

4. In the Control - ImageXpress Ultra Beam Splitter Settings dialog, 
verify that the main beam splitter position has been updated 
and that no error messages appear.

5. Click Done and then click OK to close the dialog.

Note: The main beam splitter wheel automatically self-aligns so 
there is a slight delay of up to 15 seconds when changing beam 
splitters.
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Verifying Acquisition Settings in the Meta Imaging Series 
Administrator 

Complete the following procedure to make sure that the ImageXpress 
Ultra System acquisition driver is installed. 

To verify acquisition settings

1. Click Start > Programs > MetaXpress > Meta Imaging Series 
Administrator. 

2. In the Meta Imaging Series Administrator dialog, click Configure 
Hardware. 

3. In the Configure Hardware dialog, click Configure Acquisition. 

4. In the Configure Acquisition dialog, in the Installed Drivers field, 
make sure that ImageXpress Ultra is listed. If it is not listed, 
select it from the Available Drivers field and then click Add.

5. Click Configure and then in the ImageXpress Ultra Configuration 
dialog confirm that the Flip Horizontally and Flip Vertically check 
boxes are selected. 

Note: Although the ImageXpress Ultra System uses PMTs 
(photomultiplier tubes) instead of a camera, the PMTs are treated as a 
camera by the MetaXpress Software.
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6. In the Auto Calibration Interval field, check that the value is set to 
3600 (the default value) or to the appropriate setting for your 
instrument.

7. In the Version Information section, confirm that the serial 
number, driver, firmware, and MSP versions are listed. If there 
are no values for these fields, make sure that the cable set up is 
correct from the ImageXpress Ultra System to the computer.

8. Click OK to close the ImageXpress Ultra Configuration Camera 
Driver dialog, and then click OK to close the Meta Imaging Series 
Administrator dialog.

Verifying and Backing Up Settings in the MetaXpress 
Software

After confirming hardware settings in the Meta Imaging Series® 
Administrator, check the following in the MetaXpress Software:

• Magnification settings
• Calibration settings

During the verification process it is recommended that you backup 
these settings so that you can restore the settings if they are lost.

Note: The Auto Calibration Interval field refers to the minimum 
time interval in seconds between the automatic calibrations of 
the galvanometer at the beginning of plate acquisition.
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Verifying and Backing Up Magnification Settings
You must confirm the magnification settings for the ImageXpress Ultra 
System objectives.

To verify and back up the magnification settings

1. Open the MetaXpress Software and log in to the database.
2. Click Devices > Configure Magnification. 
3. In the Configure Magnification dialog, in the Settings section, 

make sure that the ImageXpress Objective, Beam Expander, and 
Pinhole check boxes are selected and the fields are completed. 

4. In the X, Y Offset fields make sure that the offsets are set for the 
objective (for the 10X Plan Fluor objective, the offset is 0). 

5. In the Z Escape Distance field, make sure the value is 0.
6. In the Defined Settings field, make sure that each objective in 

your system is listed.
7. Click Backup.
8. In the Backup All Magnification Settings dialog, select a name and 

location for the backup file and then click Save. The default 
location is C:\MX5\app\mmproc\DATA.

Tip! For additional information about any of the dialogs in MetaXpress 
Software, press the F1 key to access the Help for the active dialog.

Tip! Restore the settings by clicking Restore and then choosing 
the saved file.
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9. Click Close.

Verifying and Backing Up Calibration Settings 

To verify and backup calibration settings

1. In the MetaXpress software, click Measure > Calibrate Distances.
2. In the Calibrate Distances dialog, click the Setup tab and in the 

Calibrations field, confirm that the calibration settings match the 
objective settings in the Configure Magnification dialog. Make 
sure the appropriate magnification setting is selected for each 
calibration. See Table A-1 Nikon Objectives Compatible with the 
ImageXpress Ultra System on page 173 for the distance 
calibrations for specific objectives.

3. Click Save to File. 
4. In the Save Spatial Calibrations dialog that appears, select a name 

and location for the backup file and then click Save. The default 
location is C:\MX5\app\mmproc\DATA.

5. Click Close.

Tip! Restore the settings by clicking Load from File and then 
choosing the saved file.
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Verifying the Laser Autofocus Sensor
This procedure uses a bead plate to test that the laser autofocus sensor 
is enabled and functional. 

To verify the laser autofocus response

1. In the MetaXpress Software, click Screening > Plate Acquisition 
Setup.

2. Click the Plate tab and in the Plate name field, select Bead Plate.
3. Click the Objective and Camera tab and then select the 10X Plan 

Fluor objective.
4. Click Screening > Plate Acquisition and Control.
5. In the Plate Acquisition and Control dialog, click Eject Plate to move 

the stage to the load position.

6. Load the bead plate and then click Load Plate.
7. Click Go To A1 to move the stage to the A1 position.
8. In the Plate Acquisition Setup dialog, click the Autofocus tab.
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9. Click Configure Laser Settings 
The Configure Laser Autofocus Settings dialog appears.

10. Click Preview Pass. 
The Preview Pass dialog appears displaying a graph of focus 
intensities versus Z position.
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11. In the Configure Laser Autofocus Settings dialog, click Close.

Note: If the Preview Pass window contains at least one peak, the 
laser autofocus sensor is enabled and functional. If the Preview 
Pass window does not contain any peaks, make sure that the 
plate is properly seated, increase the Exposure value in the 
Configure Laser Autofocus Settings dialog, and then try again. If 
the chart still does not contain a peak, contact Technical 
Support and report the issue. For more information on the 
Preview Pass window, see To configure laser autofocus on 
page 118.
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Verifying the Plate Reference Point (A1 Center) 
You need the metal X/Y calibration plate/slide holder that ships with the 
ImageXpress Ultra System to complete this procedure.

To set the plate reference point (A1 center) 

1. In the MetaXpress Software, click Screening > Plate Acquisition 
Setup.
The Plate Acquisition Setup dialog appears.

2. Click the Objective and Camera tab and then do the following:
In the Magnification field, select 10X Plan Fluor.
In the Pixel Binning field, type 2.
In the Scan lines field, type 2000.
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3. Click the Plate tab.
4. In the Plate name field, click 96 Wells (8×12).
5. Click the Sites to Visit tab and select Single site.
6. Click the Acquisition Loop tab and in the Emission filters field, click 

Empty, in the Beam splitter field, click 90-10 to create a 
reflectance channel. In a system with no empty filter sets, you 
must remove one of the filter sets to perform this operation. 

.

7. In the Excitation Lasers section, in the 635 nm Power field, type 
10.

8. In the Wavelength collection section, in the PMT4 Gain field, type 
150.

9. Click Screening > Plate Acquisition and Control. 
10. In the Plate Acquisition and Control dialog, in the Step size field, 

type 250.

WARNING! Turn off the ImageXpress Ultra System when 
removing emission filter sets.
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11. Click Eject Plate to move the stage to the load position.
12. Load the metal X/Y calibration plate and make sure that the 

notch in the plate is in the A1 position on the stage.
13. Click Load Plate to load the plate.
14. Click Go To A1 to move the stage to the A1 position.
15. In the Plate Navigation section, adjust Z until it is at 6000 µm 

above the bottom position (typically the bottom position is 
indicated as 0 µm).

16. In the Step size field, type 20 µm.
17. Click Snap Current.
18. Use the Z control arrows to step the Z motor (reducing the step 

size as you get closer to focus if needed) and then click Snap 
Current until the A1 calibration hole comes into focus.
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:

19. Verify that the hole is visually centered in the field of view. If it 
is not, or if you cannot find the hole, contact Technical Support.

20. In the Plate Acquisition and Control dialog, click Eject Plate to eject 
the X/Y calibration plate.

Note: The A1 Calibration pinhole will always fit in the field-of-
view of the ImageXpress Ultra System with a 10X objective (as 
long as the image is 2000 scan lines).
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Verifying Plate Types
You must verify that the preconfigured plate type files included with the 
MetaXpress Software are available from the Plate Acquisition Setup 
dialog.

To verify plate types

1. In the MetaXpress Software, click Screening > Plate Acquisition 
Setup and then click the Plates tab.

2. Click the Plate name list to view the available plate type files and 
check that a number of custom plates are available.

Adding Pre-configured Plate Types
If there are no plate types listed other than the three defaults, 96 Wells 
(8×12), 384 Wells (16×24), and Custom, then the preconfigured plate 
type files are not loaded and you must add them.

To add pre-configured plate types

1. Insert the MetaXpress Software installation USB flash drive into 
the computer.

2. In the MetaXpress Installation screen that appears, click Explore 
Installation Folders/Files.

3. Open the Plates folder. 
This folder contains the preconfigured plate type files (.plt).

4. Copy the plate files to the Plates directory of the MetaXpress 
Software installation directory. The default location is 
C:\MX5\Plates. 
These files appear in the Plate name list in the Plates tab of the 
Plate Acquisition Setup dialog.

5. As the plate files are Read-only after they are copied from the 
flash drive, you must turn off the Read-only attribute by 
selecting all the plate files that you copied to the Plates directory 
(Shift + click to select multiple continuous items), right-click the 
selected files, and then select Properties. 
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6. In the Properties dialog, in the Attributes section, clear the Read-
only check box and then click OK.

Confirming Laser Autofocus Settings for Plate Files
Just before each site is acquired during plate acquisition, the laser 
autofocus system automatically moves the vertical (Z-axis) position of 
the objective to a point where the bottom of the well is in focus. Before 
using a plate file, confirm that the laser autofocus settings are optimal 
for the plate. You must prepare the plate that you are going to test by 
putting water or buffer similar to the buffer you will be using for real 
experiments in several of the wells.
If you are using an objective with a correction collar, make sure that 
the correction collar is set appropriately for the plate you are using. See 
Adjusting the Spherical-Aberration Correction Collar on Objectives on 
page 165.
Use the Laser Autofocus Wizard, available on the Plate tab, to confirm 
laser autofocus settings. The wizard walks you through the process. 
Additional information about the settings that the wizard calculates is 
available in the online help, in the topic “Configure Laser Autofocus 
Settings - Dialog Box Options.”

Verifying Shading Correction Files
Shading correction files are required for each objective and filter 
combination and must be generated whenever an objective or filter is 
replaced or added to the system. There will also be a weaker effect on 
shading of the beam expander setting. Shading correction files must be 
generated with a pinhole diameter of 1 mm. These files are applicable 
to images generated with other pinhole settings. The image scan length 
of the shading files must exceed that of your acquired image for 
effective shading correction to be applied. See Generating Shading 
Correction Files on page 105.

To use shading correction images during plate acquisition

1. In the Plate Acquisition Setup dialog, in the Acquisition Loop tab, 
select the Perform shading correction check box.

2. In the Scan tab, select a shading correction file for each active 
PMT.

Note: The Laser Autofocus Wizard calculates measurements as 
accurately as possible. Some manual verification and adjustment of 
the settings may be necessary to optimize the results, particularly for 
thin-bottom plates. Contact Technical Support if you need assistance.
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Guidelines for Planning Experiments
This chapter provides information on:
• Planning High-Content Experiments on page 63
• Obtaining Quality Images on page 64
• Additional Guidelines for Planning Experiments on page 65

Planning High-Content Experiments
When acquiring fluorescence images in a screening environment, follow 
a basic set of rules and guidelines to acquire quality images. 
As with any biological assay, you must evaluate the assay conditions 
required to obtain a meaningful result. Include in your sample 
preparation both negative and positive controls so you can judge the 
validity of your assay and optimize experimental conditions. Molecular 
Devices recommends using a nuclear stain such as DRAQ5, Hoechst 
33342 or DAPI to stain your cells, since this stain can be used for image 
segmentation as part of your analysis. 
While image enhancement tools and options are available in the 
MetaXpress Software, it is difficult to analyze a poor quality image. 
Starting with quality images ensures that your image data is more 
meaningful, and yields more information. Part of assay optimization 
includes the image analysis of positive and negative controls to make 
sure that the imaging conditions are sufficient to distinguish these 
cases.
The following are some criteria to consider for attaining the highest 
possible high-content assay results:

• cell lines
• treatment conditions
• staining conditions
• dyes
• fixation conditions
• microplate choice
• media
• laser lines and filters
• objectives 
• binning
• averaging
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Obtaining Quality Images
The following conditions or situations can interfere with obtaining the 
highest quality images.

Table5-1 Conditions that Interfere with Quality Images

Condition Description and Possible Corrective Actions

Optics are degraded 
by dust, dirt, 
fingerprints, or oil 
contamination

If you detect any contamination on your objectives, 
you should inform your system administrator, who can 
take steps to clean the optics and correct the problem.

Uneven background The first step to correct an uneven background is to 
check for uneven illumination. If the illumination is 
uneven during fluorescence acquisition, contact your 
system administrator. 

Poor quality 
microplates

Not all microplates are the same quality. The 
composition of the bottom of the microplate must be 
of optical quality, or the images can be degraded. For 
fluorescence imaging, microplates with black well 
sides and flat clear bottoms usually work the best. 
Plastic-bottom plates are usually more uneven and 
distort light more than glass-bottom plates.

Incorrect microplates If you are screening multiple plates, make sure that all 
plates are the same type and from the same 
manufacturer. Well spacing can vary slightly and plate 
bottom thickness can vary significantly from one 
manufacturer to another. It is not possible to 
continuously change the plate settings during a single 
experiment run.

Plate bottom quality 
degraded by dust, 
dirt, fingerprints, or 
oil contamination on 
the microplate

Since the laser measures the reflection from the 
bottom of the plate or from the bottom of the well, 
interference with reflections caused by dust particles, 
dirt, fingerprints, and scratches affects the 
performance of the autofocus. Clean the bottom of the 
plate using lens tissue and an optical cleaning solution 
to improve the autofocus. Dust, dirt, fingerprints, or 
oil contamination on the bottom of the microplate can 
also reduce image quality.
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Additional Guidelines for Planning Experiments

Sample Preparation
Media with a refractive index similar to that of the microplate (for 
example, media containing glycerol) can make it difficult to focus on 
the bottom of the well due to the weak reflection of the autofocus laser 
beam. Media containing dyes such as Phenol Red increase the 
background fluorescence in the images. Therefore, a clear buffer such 
as PBS (phosphate buffered saline) is recommended. You must have 
sufficient volume in the wells so that the fluid is 2.5 mm above the 
sample. In addition, avoid bubbles in the sample, for both image 
quality and autofocus performance.

Laser Power

To find the optimal laser power for your sample 

1. Acquire the same image from a typical sample at different laser 
powers (starting with low powers first).

2. Plot fluorescence intensity versus the laser power. The resulting 
graph provides an estimate of the safe range of illumination 
intensities (that is, intensities that are below the saturation level 
of the dye). 

The following figures show three examples of such an experiment. The 
figures show the average GFP fluorescence intensity of the non-
saturated portion of the image as a function of the percent of maximum 
power of the 488 nm laser set in the software. A significant deviation 
from the linear behavior (decreasing slope) indicates that there is a 
diminishing advantage to further increasing the laser power. 
The first experiment (Figure 5-1) shows that the intensity is low even 
at 100% laser power. The second experiment (Figure 5-2) shows 
intensity being maximized at close to 60% laser power. The third 
experiment (Figure 5-3) shows a system where increasing laser power 
to 40% gives maximum intensity, and to 50% and above causes a 
reduction in intensity. 
The plots serve as an example and appropriate laser power ranges vary 
for different optical configuration and dye combinations. For optimal 
data quality, run similar calibration experiments with the specific 
objective, beam expander, beam splitter, plate type, and assay type 
that you intend to use.

Note: Increasing the laser power increases the brightness of acquired 
images, however, excessive laser power has the potential to saturate 
the dye and photobleach your sample without increasing image 
brightness.
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Figure 5-1 Objective:10X Plan Fluor, expander – 3x, 
beam splitter – 20/80. PMT voltage = 550 V

Figure 5-2 Objective – 20X ELWD, expander – 2x, 
beam splitter – 488/635 dual notch. PMT voltage = 550 V

Note: Laser intensities below 10% are not stable and are not accepted 
by the instrument firmware.
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Figure 5-3 Objective – 40X ELWD, expander – 1x, 
beam splitter – 488/635 dual notch. PMT voltage = 600 V

Objective Choice
The choice of objective determines the magnification, the depth of field, 
and the brightness of the image. A key attribute of the objective is the 
numerical aperture (NA). With the magnification constant, brightness 
increases quickly with the increasing NA. 
Higher NA objectives produce a sharper picture due to a narrower 
depth of field. This can be an advantage if some of your objects are in 
different Z positions. However, higher NA short working distance 
objectives cannot reach the outer rows and columns of some multiwell 
plates because of the plate’s skirt height, causing the edge of the 
objective to collide with the plate skirt or with the ribs connecting the 
plate skirt to the well region. 
Imaging through a thick-bottom plate (for example, 0.5 to 1 mm) is 
also degraded with high NA objectives unless they have suitable 
spherical-aberration correction collars. The Nikon ELWD (extra long 
working distance) objectives are suitable for focusing through thick 
plates. See Appendix A: Objectives Compatible with the ImageXpress 
Ultra System on page 173 for the Nikon objectives compatible with the 
ImageXpress Ultra System.
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Use of Different Fluorophores
Individual fluorophores have unique characteristics that help determine 
their best use. Some fluorophores provide brighter intensities and 
require low laser power, while others do not bleach as quickly. 
There also might be toxicity issues with some cell types or bleed-
through issues between pairs of fluorophores. 
These factors should be considered when choosing a fluorophore.

Dyes and Applications for the ImageXpress Ultra 
System
The following tables detail the dyes and applications for each laser that 
you can use in the ImageXpress Ultra System. The probes that have 
been validated on the ImageXpress Ultra System by Molecular Devices 
are also indicated in the tables. Other probes that are listed in the 
tables are predicted to work to some extent with the indicated lasers 
but their performance on the system cannot be guaranteed.

Note: The list of potential dyes and applications for each laser is not 
intended to be an exhaustive list of all possible probes.

Table5-2 405 Laser

Dyes Applications
Detection 
theoretically 
possible with 
Emission Filters

Validated on the 
ImageXpress Ultra 
System by 
Molecular Devices

DAPI DNA (nuclear) 
staining

Yes (417-447 filter) Yes

Hoecht 
33342

DNA (nuclear) 
staining

Yes (417-447 filter) Yes

Alexa 405 Secondary 
antibody or 
streptavidin 
staining

Yes (417-447 filter) No

Alexa 430 Secondary 
antibody or 
streptavidin 
staining

Yes (525/50 filter, 
others possible)

No
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Cyan 
fluorescent 
protein (CFP) 
(not optimal 
for 405 
laser)

Live cell protein 
dynamics, FRET 
with YFP

Yes (525/50 filter, 
others possible)

No

Blue 
fluorescent 
protein

Live cell protein 
dynamics

Yes (417-447 filter) No

Pacific Blue Secondary 
antibody or 
streptavidin 
staining

Yes (417-447 filter) No

Lucifer 
Yellow

Neuronal tracing Yes (525/50 filter, 
others possible)

No

CellTrace 
calcein violet 
405

Live cell 
identification

Yes (417-447 filter) No

LIVE/DEAD 
Fixable Violet 
Dead Cell 
Stain

Dead cell 
identification

Yes (417-447 filter) No

LIVE/DEAD 
Fixable Aqua 
Dead Cell 
Stain

Dead cell 
identification

Yes (525/50 filter, 
others possible)

No

Photoactivat
able GFP 
(PA-GFP)

Live cell protein 
dynamics

Not Applicable (405 
laser used for 
activation only)

No

Table5-2 405 Laser (cont’d)

Dyes Applications
Detection 
theoretically 
possible with 
Emission Filters

Validated on the 
ImageXpress Ultra 
System by 
Molecular Devices
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Table5-3 488 Laser

Dyes Applications

Detection 
theoretically 
possible 
with 
Emission 
Filters

Validated on the 
ImageXpress Ultra 
System by 
Molecular Devices

GFP Live cell protein 
dynamics

Yes (500-520 or 
525/50 or 496-
580)

Yes

EGFP Live cell protein 
dynamics

Yes (500-520 or 
525/50 or 496-
580)

Yes

FITC Secondary antibody 
or streptavidrin 
staining

Yes (500-520 or 
525/50 or 496-
580)

Yes

Alexa 488 Secondary antibody 
or streptavidrin 
staining

Yes (500-520 or 
525/50 or 496-
580)

Yes

BODIPY FL Coupled to various 
small compounds

Yes (500-520 or 
525/50 or 496-
580)

Yes

Calcein Live cell 
identification

Yes (500-520 or 
525/50 or 496-
580)

No

Yellow 
fluorescent 
protein (YFP)

Live cell protein 
dynamics, FRET 
with CFP

Yes (525/50 
filter or 
496-580)

No

Oregon 
green

Fluorescein analog Yes (500-520 or 
525/50 or 496-
580)

No

Rhodamine 
green

Secondary antibody 
or streptavidrin 
staining

Yes (500-520 or 
525/50 or 496-
580)

No

Acridine 
Orange 

Dye (nuclear) 
staining

Yes (500-520 or 
525/50 or 496-
580)

No

7-AAD (7-
Aminoactino
mycin D) 

Dye (nuclear) 
staining

Yes (685/40) No

Ethidium 
Bromide 

Dye (nuclear) 
staining

Yes (565-605 or 
593/40)

No
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SYTOX 
Green 

Dye (nuclear) 
staining

Yes (500-520 or 
525/50 or 496-
580)

No

BCECF Intracellular pH 
measurements

Yes (500-520 or 
525/50 or 496-
580)

No

Calcium 
Green 

Intracellular Ca2+ 
measurements

Yes (500-520 or 
525/50 or 496-
580)

No

Carboxy-
SNARF (R)-
1-AM pH 6

Intracellular pH 
measurements

Yes (565-605 or 
593/40)

No

JC-1 Mitochrondrial 
membrane potential

Yes (565-605 or 
593/40)

No

DiO Membrane staining 
for cell tracking

Yes (500-520 or 
525/50 or 496-
580)

No

Fluo-3 Intracellular Ca2+ 
measurements

Yes (500-520 or 
525/50 or 496-
580)

No

NBD-C6 Golgi staining Yes (500-520 or 
525/50 or 496-
580)

No

Table5-3 488 Laser (cont’d)

Dyes Applications

Detection 
theoretically 
possible 
with 
Emission 
Filters

Validated on the 
ImageXpress Ultra 
System by 
Molecular Devices
0112-0149 F 71 



Guidelines for Planning Experiments
Table5-4 532 Laser

Dyes Applications

Detection 
theoretically 
possible with 
Emission 
Filters

Validated on the 
ImageXpress Ultra 
System by 
Molecular Devices

Cy3 Secondary 
antibody or 
streptavidin 
staining

Yes (565-605) Yes

Rhodamine Secondary 
antibody or 
streptavidin 
staining

Yes (565-605) Yes

TRITC Secondary 
antibody or 
streptavidin 
staining

Yes (565-605) Yes

MitoTracker 
Orange

Mitochondrial 
staining in live 
cells

Yes (565-605) Yes

Alexa 532 Secondary 
antibody or 
streptavidin 
staining

Yes (565-605) Yes

Alexa 546 Secondary 
antibody or 
streptavidin 
staining

Yes (565-605) No

Alexa 555 Secondary 
antibody or 
streptavidin 
staining

Yes (565-605) No

Alexa 610-
RPE

Secondary 
antibody or 
streptavidin 
staining

Possibly (565-605) No

R-
phycoerythri
n (R-PE) 

Secondary 
antibody or 
streptavidin 
staining

Yes (565-605) No

Calcium 
Orange

Intracellular 
Ca2+ 
measurements

Yes (565-605) No
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Dil Membrane 
staining for cell 
tracking

Yes (565-605) No

Propidium 
Iodide (PI)

DNA (nuclear) 
staining in dead 
cells

Yes (565-605) No

POPO-3 DNA (nuclear) 
staining 

Yes (565-605) No

PO-PRO-3 DNA (nuclear) 
staining in dead 
cells

Yes (565-605) No

TAMRA Oligonucleotide 
labelling

Yes (565-605) No

Ethidium 
homodimer 
(LIVE/DEAD)

DNA (nuclear) 
staining in dead 
cells

Yes (565-605) No

Table5-5 561 Laser

Dyes Applications

Detection 
theoretically 
possible with 
Emission 
Filters

Validated on the 
ImageXpress Ultra 
System by 
Molecular Devices

TRITC Secondary 
antibody or 
streptavidin 
staining

Yes (593/40) Yes

Texas Red Secondary 
antibody or 
streptavidin 
staining

Yes (593/40) Yes

Mitotracker 
Red

Mitochondrial 
staining in live 
cells

Yes (593/40) Yes

DsRed Live cell protein 
dynamics

Yes (593/40) Yes

Table5-4 532 Laser (cont’d)

Dyes Applications

Detection 
theoretically 
possible with 
Emission 
Filters

Validated on the 
ImageXpress Ultra 
System by 
Molecular Devices
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Alexa 555 Secondary 
antibody or 
streptavidin 
staining

Yes (593/40) Yes

Alexa 568 Secondary 
antibody or 
streptavidin 
staining

Yes (593/40) No

Alexa 594 Secondary 
antibody or 
streptavidin 
staining

Yes (593/40) No

Alexa 610 
(not optimal)

Secondary 
antibody or 
streptavidin 
staining

No No

Alexa 610-
RPE

Secondary 
antibody or 
streptavidin 
staining

No No

R-
phycoerythri
n (R-PE)

Secondary 
antibody or 
streptavidin 
staining

Yes (593/40) No

Dil Membrane 
staining for cell 
tracking

Yes (593/40) No

Calcium 
Crimson

Intracellular Ca2+ 
measurements

Yes (593/40) No

LysoTracker 
Red

Lysosome 
staining in live 
cells

Yes (593/40) No

Rhodamine 
Red

Secondary 
antibody or 
streptavidin 
staining

Yes (593/40) No

Nile Blue 
(not optimal)

Lipid staining in 
fixed cells

No No

Table5-5 561 Laser (cont’d)

Dyes Applications

Detection 
theoretically 
possible with 
Emission 
Filters

Validated on the 
ImageXpress Ultra 
System by 
Molecular Devices
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Table5-6 635 Laser

Dyes Applications

Detection 
theoretically 
possible with 
Emission 
Filters

Validated on the 
ImageXpress 
UltraSystem by 
Molecular Devices

DRAQ5 DNA (nuclear) 
staining

Yes (685/40) Yes

Cy5 Secondary 
antibody or 
streptavidin 
staining

Yes (685/40) Yes

TO-PRO-3 DNA (nuclear) 
staining in dead 
cells

Yes (685/40) Yes

Alexa 633 Secondary 
antibody or 
streptavidin 
staining

Yes (685/40) No

Alexa 635 Secondary 
antibody or 
streptavidin 
staining

Yes (685/40) No

Alexa 647 Secondary 
antibody or 
streptavidin 
staining

Yes (685/40) Yes

Cy5.5 Secondary 
antibody or 
streptavidin 
staining

Yes (685/40), not 
optimal

No

BODIPY 
630/650

Protein 
conjugation

No No

DiD Membrane 
staining for cell 
tracking

Yes (685/40) No

CellMask 
Deep Red

Plasma 
membrane 
staining

Yes (685/40) No
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Incompatible Probes
The following table details some probes that might not work well with 
any of the available lasers. 

Table5-7 Incompatible Probes

Dyes and Applications Notes

Any QDots Fluorescent lifetime is much 
slower than the point scanning

CellMask Blue

Marina Blue

LysoTracker Blue

Indo-1

Hoechst 33258

DiR

Alexa 750

Alexa 790

Alexa 350
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Plate Selection
There are numerous types of multiwell plates available from a variety of 
vendors. Molecular Devices recommends that you determine the plates 
to use for your screening experiments based on the guidelines in the 
following table.

Table5-8 Plate Selection Guidelines

Guideline Description

Cell Compatibility Verify that your cells are compatible with the plate 
material. Given the wrong surface, some cells might 
not bind and will act in an unusual manner, such as 
rounding up or migrating to the edges of the well. 
Plastic plates tend to show higher background staining 
as compared to glass plates. 

Fluorescence 
background

There is a difference in auto fluorescence between 
glass and plastic. In addition, there can be up to a 
five-fold difference in auto fluorescence among plates 
from different manufacturers. If your signal-to-
background ratio is low, try other brands of plates as a 
first step in troubleshooting.

Note: Black plates with clear bottoms are 
superior to all-clear plates.

Plate skirt height If you are using a high NA or short working distance 
objective you should use a plate with a short skirt 
height (the height is the difference between the edge 
of the plate and the bottom surface of the wells). If 
the skirt height is too high, you might not be able to 
image the outermost parts of a plate (the outermost 
rows and columns on a 384-well plate or some sites on 
the outermost rows and columns on a 96-well plate).

Note: The skirt height referred to is not the 
same as the flange height described in the ANSI 
(SBS) standard.

High-magnification 
image clarity

When using high magnifications, there are significant 
differences in clarity between standard plastic plates, 
optically clear plastic plates, and glass-bottom plates.

Plate flatness and 
reproducibility of the 
Z pattern

A truly flat plate is faster to scan than an uneven plate 
because the autofocus search range can be made 
smaller. The reproducibility of a plate allows you to set 
tighter focus ranges for a specific plate type. This 
reduces the amount of focusing needed and speeds up 
acquisition. The primary impact of plate flatness on 
throughput is the typical variation from one well to a 
neighboring well (rather than the total plate flatness). 
In general, glass plates are flatter than plastic plates.
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Outside edge of the 
plate

If you use a plate-handling robot, some types of plates 
do not work well with the fingers supplied with the 
robot and might require custom fingers from the 
robotics vendor to work correctly.

Plate-to-plate 
reproducibility

Plates can vary in their behavior from one 
manufacturing lot to another. Your assay will perform 
better if the plates do not vary significantly.

Plate bottom 
thickness

The plate bottom thickness must be compatible with a 
range of working distances for the specific objective 
being used. See Table A-1 Nikon Objectives 
Compatible with the ImageXpress Ultra System on 
page 173.

Table5-8 Plate Selection Guidelines (cont’d)

Guideline Description
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6
Setting Up Plate Acquisition
Before configuring an experiment, it is important to become familiar 
with the tools used in the MetaXpress® High Content Image Acquisition 
and Analysis Software. The foundation of the MetaXpress Software is 
MetaMorph® Software. The MetaMorph Software contains numerous 
dialogs for image acquisition, processing, and analysis. However, the 
majority of the dialogs available are not needed for a typical 
MetaXpress Software plate acquisition. This chapter explains the 
dialogs and procedures required to configure a screening experiment. 

The chapter contains the following:
• Overview on page 80
• Creating Experiments on page 83
• Naming the Experiment on page 86
• Configuring Binning, Averaging, and Scan Lines Settings on 

page 87
• Determining Plate Optical Thickness and Plate Bottom Variation 

on page 91
• Configuring Plates on page 91
• Optical Thickness and Laser Focus on page 94
• Defining Protocol Settings on page 105
• Configuring Autofocus Settings on page 118
• Running Journals During Acquisition on page 125
• Configuring the Display Settings on page 127
• Selecting a Data Analysis Method on page 129
• Reviewing the Plate Acquisition Settings on page 131
• Saving Acquisition Settings on page 133

Note: For more information on any MetaXpress Software dialog, press 
the F1 key to access the Help in the MetaXpress Software application.
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Overview 
This section describes the main MetaXpress Software components that 
you will use when you are configuring the ImageXpress® Ultra System 
for plate acquisition.

Screening Menu
The Screening menu provides access to all plate acquisition-specific 
dialogs: 
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Plate Acquisition and Control dialog
The Plate Acquisition and Control dialog provides two primary 
functions:

• Plate Navigation provides manual control of some of the 
movable physical components of the ImageXpress Ultra System.

• Acquisition Control enables you to prepare and start a plate 
acquisition. 

In the Plate Navigation section, use the X, Y arrow buttons on the left 
to move the plate manually from one well to another on the X and Y 
axes. 
If sites are enabled, the currently selected site is displayed below the 
arrow buttons along with the selected well. When you move from well 
to well, the selected site will remain the same. 
To change the site selection, use the site selection buttons on the Plate 
Acquisition tool bar, or the Sites to Visit tab fields of the Plate 
Acquisition Setup dialog.

The Acquisition Control section groups commands that can also be 
found in other dialogs. These controls enable you to save settings, load 
settings that have previously been saved, open the Plate Acquisition 
Setup dialog, specify a new experiment base name, choose the 
wavelength that you want to use, snap an image using the current 
wavelength, preview the current selection of wells, and acquire an 
entire plate or all wells selected on the plate.
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Plate Acquisition Setup dialog
To acquire data using the ImageXpress Ultra System, you must 
configure the settings in the Plate Acquisition Setup dialog. The Plate 
Acquisition Setup dialog is organized in a “top-to-bottom” structure 
designed to guide you through the process of setting up your 
MetaXpress Software configuration in the correct order. 
The Plate Acquisition Setup dialog is a multi-tabbed dialog in which the 
number of visible tabs can change according to the options that you 
have selected and the number of wavelengths that you are acquiring. 
Each tabbed section of the dialog is dedicated to a specific type of 
setting. 
When configuring the Plate Acquisition Setup dialog, settings might be 
highlighted either in yellow or red. A yellow highlight can mean that an 
optional field is not filled in or could indicate a minor error. A red 
highlight means that a required field is either not filled in or contains 
invalid data that should be changed. These visual reminders help when 
configuring an experiment. 
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Creating Experiments
You can configure new settings for your experiment or create 
experiments using an existing settings file. 

To create a new experiment

1. In the Plate Acquisition Setup dialog, click the Experiment tab and 
then click Create new settings.

2. Complete the information in all the tabs in the Plate Acquisition 
Setup dialog following the order of the tabs. 
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To create an experiment using an existing settings file

You can load a settings file that was saved to the database or that was 
saved outside the database, for example, on the desktop or a network 
drive.

1. Select Load existing settings file. 
The Load Settings button is displayed.

2. Click Load Settings. 
The Load Plate Acquisition Setting dialog appears.

3. If you are using a settings file (.hts) that was saved to the 
database, select the required file and then click OK. The file 
loads from the database and the Load Plate Acquisition Setting 
dialog closes.
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4. If you are loading a settings file that was saved outside the 
database, select From File and then click OK. You are prompted 
to navigate to the required settings file, select it and then click 
Open. The settings file loads and the Load Screen Acquisition 
dialog closes.

5. Click Summary to review and confirm your settings.

Note: You can load all components or selected components of a 
saved settings file.
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Naming the Experiment
After you have selected your settings file or created a new settings file, 
you must designate a name and description for your experiment, and 
choose the storage location for your experiment data. 

To add an experiment set name, base name, and 
description

1. In the Experiment Set field, type a name to sort and group 
experiments.

2. In the Experiment base name field, type a base file name for all 
image files in the experiment.

3. In the Storage Location field, select where screening images are 
saved. If a location is not available or you are unsure about 
where to store the images, contact your system administrator.
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4. In the Description field, type information about the experiment 
set. This is stored with the image information in the database.

Configuring Binning, Averaging, and Scan Lines 
Settings

For each magnification setting that you have defined, you can edit the 
camera binning and the number of scan lines. These settings enable 
you to improve either the image acquisition speed or the image quality. 
If sufficient light is available, lower camera binning increases image 
resolution.

Binning Overview
Binning of an image can be beneficial for low intensity images, since it 
increases the signal-to-noise ratio and reduces the image file size. In 
this process, you lose resolution since you are grouping pixels together. 
For example, a 2 × 2 binning will combine the signals of four pixels into 
a single pixel, resulting in a reduction of your image from 100% 
maximum size to 25% of its maximum size. Image acquisition time is 
inversely proportional to the binning number (2x binning generates an 
image twice as fast as no binning).
The ImageXpress Ultra System is a scanning system and binning is 
implemented in a different fashion than in a CCD camera. 
Horizontal scan lines in the ImageXpress Ultra System are acquired 
with the internal galvanometer scanning mirror. Each scan line is 
composed of a series of very fast (several ns) 8-bit samples. Sets of 32 
sequential 8-bit samples are summed to 13-bit numbers. Each 13-bit 
number is left-shifted 3-bits to become an 16-bit number, representing 
a pixel. Each scan line has 2000 pixels. 
Each image is composed of a series of horizontal scan lines. The test 
sample is moved in the vertical (Y) direction by the XY sample stage, 
allowing the acquisition of a user-selected number of scan lines (up to 
32,000). 

Note: Image storage locations are configured using the 
MDCStoreTools utility. If a location does not appear in this list, 
add it to the list using the MDCStoreTools utility. See the 
MDCStoreTools User Guide included on the MetaXpress 
Software installation USB flash drive and in the Molecular 
Devices knowledge base at 
www.moleculardevices.com/Support.html (follow the links to 
the knowledge base).
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With 2x binning selected, 64 sequential 8-bit samples are summed for 
each pixel in the horizontal direction, resulting in 1000 pixels in each 
scan line. The 64 summed samples make a 14-bit number, which is 
shifted 2 bits to become a 16-bit number. For greater than 2x binning, 
the number of samples summed together is correspondingly increased, 
with the final pixel value always being represented as a 16-bit number. 
Each line has 2000 pixels divided by the amount of binning.
The size of each pixel in an image is: 

(Binning * 16mm) / (2000 * Objective Magnification)
For example, an image acquired with a 40X objective and 2x binning 
will have (2 * 16 mm) / (2000 * 40) = 0.4 um pixels. The pixels are 
always square.
The size of the scanned sample region is independent of binning. The 
specified number of scan lines is divided by the amount of binning, 
while the Y-stage speed is multiplied by the amount of binning. 
The galvanometer frequency is fixed at 1 KHz and scanning is done 
bi-directionally. The total acquisition time for an image is the number of 
scan lines multiplied by 0.5 ms.
The following set of conditions will be obtained with a 40X objective 
with or without binning, where 2000 scan lines have been specified:

The scanned region in a scanning system is comparable to the field-of-
view in an imaging system.
While binning in a CCD camera increases the apparent brightness of an 
image, it will not do so in the ImageXpress Ultra System. However, 
there is a signal-to-noise reaction benefit of binning because the 
random noise level will be reduced due to the increased number of 
samples assigned to each pixel. See Combined Binning and Averaging 
on page 89.

Table6-1 Binning Conditions

Binning Scan 
Lines

Pixel 
Size 
(µm)

Image 
Size 
(pixels)

Image 
Size 
(MB)

Scanned 
Region 
(µm)

Scan 
Time 
(ms)

1x (no 
binning)

2000 0.2 x 0.2 2000 x 2000 8 400 x 400 1000

2x 1000 0.4 x 0.4 1000 x 1000 2 400 x 400 500

4x 500 0.8 x 0.8 500 x 500 0.5 400 x 400 250
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Scan Lines and Averaging Overview
The number of scan lines refers to the movement of the stage in the Y 
direction only. The maximum value is 32,000 lines. The width of the 
image is fixed at 2,000 pixels when no binning is performed. The Scan 
lines value and the Pixel binning value determine the final size of the 
acquired image as shown in the Result image size field.
Increasing the number of times each line is scanned increases the 
signal-to-noise ratio in the resulting image at the cost of an overall 
increased scan time and potentially increased photo-bleaching. After 
you reach the maximum safe illumination intensity and the maximum 
recommended PMT voltage (750V) signal averaging is a way to increase 
the signal-to-noise ratio. Increasing the number of scan lines also 
increases the size of the image as well as the field of view. For lower 
magnification objectives, large scans might result in images that span 
multiple wells. With long scans, the quality of the images becomes even 
more dependent on plate flatness. Long scans can be beneficial when 
imaging large continuous structures such as extended neurite 
outgrowths. 
Averaging in the ImageXpress Ultra System is accomplished by slowing 
the motion of the vertical (Y) stage during acquisition. For 2x 
averaging, the stage moves at half-speed. Pixels in each scan line are 
still acquired in the same fashion as without averaging. However, pairs 
(or sets for greater than 2x averaging) of pixels in adjacent scan lines 
are averaged with the result assigned to a single pixel. Therefore, 
averaging has a similar signal-to-noise effect as binning but without the 
reduction in resolution and image size.

Combined Binning and Averaging
The closest ImageXpress Ultra System equivalent to 2 x 2 binning in a 
CCD camera-based system is 2x binning and 2x averaging. In this case, 
the scanned region and scan time are unchanged but each pixel is 
assigned the collected light for a 2 x 2 pixel region. The conditions 
obtained with combined binning and averaging are shown in the table 
below for a 40X objective where 2000 scan lines have been specified. 

Table6-2 Combined Binning and Averaging Conditions

Binning Averaging Scan 
Lines

Pixel 
Size 
(µm)

Image 
Size 
(pixels)

Scanned 
Region 
(µm)

Scan 
Time 
(ms)

1x (none) 1x (none) 2000 0.2 x 0.2 2000 x 2000 400 x 400 1000

2x 2x 1000 0.4 x 0.4 1000 x 1000 400 x 400 1000
0112-0149 F 89 



Setting Up Plate Acquisition
To change the binning and scan lines settings

1. In the Magnification list, select the magnification setting to use. 

2. In the Pixel Binning field, select the amount of binning.
3. In the Scan lines field, select the number of scan lines used to 

acquire the image. 
4. Click Calibrate Galvo to calibrate the system data acquisition 

timing to eliminate the pixel shift between successive scan lines. 
This calibration also occurs automatically before a plate is 
acquired. 

Note: The settings available in the list were created in the 
Configure Magnification dialog in the Devices menu. 
Magnification settings have a calibration and assign X and Y 
offset values and a Z escape distance to a specific objective. 
You must assign a calibration to the magnification setting using 
the Calibrate Distances dialog. See Verifying and Backing Up 
Settings in the MetaXpress Software on page 51.
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Determining Plate Optical Thickness and Plate Bottom 
Variation

Molecular Devices strongly recommends that you use the Laser 
Autofocus Wizard, available on the Plate tab, to obtain plate bottom 
measurements. Although plate manufacturers generally provide reliable 
plate and well dimensions, you need to calculate the plate bottom 
measurements, such as average thickness and maximum variation in 
thickness of the entire plate. The Laser Autofocus Wizard walks you 
through steps to automatically calculate plate bottom settings as well 
as exposure times for each objective. Additional information about the 
settings that the wizard calculates is available in the application help, in 
the topic “Configure Laser Autofocus Settings - Dialog Box Options.”

All plate bottom values are optical thickness (also known as reduced 
thickness) measurements, as measured using the objective. The values 
are not physical thickness measurements.

Configuring Plates
You must provide the plate dimensional information required to control 
the X, Y, and Z movements of the ImageXpress Ultra System. 
Correct plate dimensional specifications ensure that:

• The imager will not make any movements that might create a 
potentially hazardous situation. 

• The laser-based autofocusing is as accurate as possible.
The MetaXpress Software has pre-defined plate types that have been 
configured. If you use an existing plate type file, you must verify the 
accuracy of the optical bottom thickness and the bottom variation on 
your plates. These parameters are critical and can vary from one 
manufacturing lot to another. In addition, plate manufacturers can 
change plate parameters without changing plate names. 

Note: The frequency of the automatic calibration is set in the 
ImageXpress Ultra System Camera Settings dialog in the Meta 
Imaging Series Administrator.

Note: The Laser Autofocus Wizard calculates measurements as 
accurately as possible. Some manual verification and adjustment of 
the settings may be necessary to optimize the results, particularly for 
thin-bottom plates. Contact Technical Support if you need assistance.
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If the plate type you are using is not listed in the Plate name field, you 
should use the Laser Autofocus Wizard available on the Plate tab to 
assign and save correct plate values for the plate type. The options 
available depend on what is selected in the Plate name list.

Note: The Laser Autofocus, optical thickness, and variance settings for 
each plate must be optimized on your instrument.
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To configure plates

1. In the Plate name field, select the plate size that corresponds to 
your plate, or select Custom to specify a non-standard plate 
configuration. The values in the remaining boxes are pre-filled 
according to what you select.
If you select 96 Wells (8×12) or 384 Wells (16×24), only the 
following options will be available for configuration: Well shape, 
Well depth, Plate height, Optical Thickness, and Bottom 
Variation.
If you select Custom, all options will be available for 
configuration, including Number of columns and Number of 
rows.

2. In the Well shape field, select a square or circular well shape. 
The graphics of the plate are updated to reflect your selection.

3. Click Laser Autofocus Wizard and follow the steps that the 
wizard provides to calculate plate bottom measurements.
The optical thickness is a value in microns that is the average 
measured thickness for the well bottom using the Laser 
Autofocus. It is proportional but not equal to the physical 
thickness of the bottom plate.
The bottom variation is a value in microns that is the maximum 
variation in Z direction between adjacent well bottoms. 

4. If required, in the Well depth and Plate height fields, change the 
values.
Correct Well depth and Plate height values are required for 
autofocusing. These values can be obtained from the 
manufacturer.

5. If you selected Custom, complete the fields as required.
6. After you have configured the plate settings, click Save 

Configuration to type a name for your setting and save the plate 
configuration. Configurations that have been saved are then 
available in the Plate name list.

Note: The Laser Autofocus Wizard calculates measurements as 
accurately as possible. Some manual verification and 
adjustment of the settings may be necessary to optimize the 
results.

Note: Adjust any objectives with correction collars to match the 
plate type.
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Optical Thickness and Laser Focus
A plate bottom typically consists of plastic or glass material. The 
transitional point between the plastic or glass and air or liquid is 
referred to as an interface. The laser in the laser autofocus system 
reflects off both interfaces: first at the plastic-to-air interface (when 
looking from the bottom of the plate through the plastic or glass 
material) at the bottom of the plate, and then at the air-to-plastic or 
liquid-to-plastic interface at the bottom of the well. The Z position 
difference between these two interfaces is called the optical thickness 
(also referred to as reduced thickness).
When the system performs a focus search with the laser, it moves from 
bottom to top, looking for the first laser spot that it can locate. This 
represents the bottom of the plate. Then the Z motor moves the 
objective by a percentage of the optical thickness and performs another 
search for the second laser spot. This is the interface of plastic-to-air or 
plastic-to-liquid. Correctly specifying the optical thickness is important 
since it ensures proper location of the second interface and thus 
accurate focusing.
After the instrument has found both interfaces, you can set it to 
perform a search for only the second interface. The search range used 
is based on the plate bottom variation that you enter in the plate 
definition. The variation between neighboring wells must be accurately 
determined for this to be effective.
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Configuring the Wells to Visit on a Plate
You can configure the wells to acquire on your plate and enable 
acquisition from multiple sites per well. The Wells to Visit tab displays a 
graphical representation of the type of plate that you are using, based 
on the settings that you made on the Plate tab.

To configure the wells to visit on a plate

1. Click the Wells to visit tab and then click individual wells to select 
or clear each well.

2. Click lettered buttons to select or clear an entire row.
3. Click numbered buttons to select or clear an entire column.
4. Click All in the upper-left corner to select or clear all wells on the 

plate.
5. Right-click a well to move the stage to the well.
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Configuring the Sites to Visit on a Plate
You can specify the acquisition of more than one location in a well and 
configure the vertical and horizontal spacing between sites in an image. 
Both positive and negative values can be entered to add a space 
between images (using positive values) or to overlap images using 
negative values.
The number of sites to acquire in a well depends on the following 
factors that can influence data quality:

• size of the well
• objective magnification
• image size (number of scan lines)
• distribution of sample material in the well
• type of plate
• location of the material in the well that you want to acquire
• amount of spacing that you require between each acquisition 

location
Focusing options for multiple sites are set on the Autofocus tab. See 
Configuring Laser Autofocus on page 118.
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To configure the sites to visit on a plate

1. In the Columns and Rows fields, specify the number of columns 
and rows (for example, 2 columns and 2 rows to acquire up to 
four sites; 3 columns and 3 rows to acquire up to nine sites).

 

2. Click Tile Sites to configure the sites with zero spacing between 
adjacent sites. 

3. Click Fit sites to well to maximize the spacing between the sites 
within the well.

4. In the graphical display, left-click individual sites to turn off any 
sites that you do not want to acquire, or to turn on any sites 
that are turned off. You can also click and drag to select or clear 
a rectangular block of sites. Right-click a site to move the stage 
to that site. 

Note: The maximum number of columns and rows that can be 
configured is 45 × 35.
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Examples 
Configure the Sites to Visit tab as shown in the screenshot to 
acquire images at the edges of a round well configured with 16 
sites.

Configure the Sites to Visit tab as shown in the screenshot to 
acquire images at the edges of a square well configured with 16 
sites.
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5. In the Spacing (µm) lists, select the X and Y values of the 
spacing between images to include a distance between adjacent 
sites.

6. In the Sites to acquire in well section, view the current image size, 
well size, and image spread values on the tab. These values 
update to reflect changes in configuration.

Note: A negative value results in overlapping data between 
adjacent images. The overlapping data can be useful if the 
images are stitched together for image analysis.
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Configuring Cell Counting
The Adaptive Acquisition option in the Sites to Visit tab is a 
computational algorithm that analyzes the cell number on the fly during 
sample acquisition, which increases the chances of collecting valid data 
in every well. Adaptive Acquisition can also significantly reduce 
acquisition time for multiwavelength acquisition requiring a minimum 
number of cells per well or for samples with differing conditions across 
the plate.

To configure cell counting

1. In the Sites to Visit tab, in the Site Acquistion Option section, click 
Adaptive acquisition. 
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2. In the Cell Counting tab, in the Wavelength list, select the channel 
to use for cell counting. 

3. In the Approximate width fields, select the approximate values 
for the width of the nuclei.

4. In the Intensity above local background field, select the intensity 
of the nuclei.
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5. Click Test settings to optimize your settings on a representative 
site as shown in the following screenshot. You should already be 
in focus at that location and in an area on your sample that has 
a representative number of cells. 

Setting Multiple Timepoints to Acquire Images
You can set the loop order to use when acquiring images at multiple 
timepoints, the number of timepoints to acquire, and the total time 
required for all timepoints. 
The values in the Number of Timepoints, Interval, and Duration fields 
have the following relationship:

Number of Timepoints × Interval = Duration

Note: Test Settings snaps an image and counts the cells using 
the current settings, displaying both an analysis overlay and the 
total number of cells counted in the image.
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To configure multiple timepoints to acquire images

1. In the Timelapse tab, in the Number of timepoints field, select the 
required number. If you change any of the values, other fields 
are updated as required.

Note: If you are not using multiple timepoints in your 
acquisition, in the Number of timepoints list, select 1 and click 
Next to move to the next tab.
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2. In the Perform time series for list, select a loop order to use when 
acquiring images at multiple timepoints. The following options 
are available:

3. In the Interval fields, select the amount of time and the time 
unit (for example, ms, sec, min, hr) between the start of 
acquisition at one time point to the start of acquisition at the 
next time point.
If the time interval is shorter than the length of time required to 
acquire the images, the next acquisition occurs as soon as 
possible after the previous acquisition is complete. The Interval 
field can be set to 0 to acquire images as fast as possible. If the 
interval is set to 0, the duration is set according to the 
approximate minimum time, and the Duration field is disabled.

Table6-3 Perform time series options

Option Description

One well, then the next A set of wavelength images is acquired at 
each site in the well at each time point. 
Use this option for rapid acquisition from a 
well if multiple sites are selected. All sites 
are acquired per time point.

One row, then the next All the images in one row of wells are 
collected at each time point. After the 
series is collected the next row is acquired. 
This option requires a longer time interval 
because all the wells in a row are acquired.

One column, then the 
next 

All the images in one column of wells are 
collected at each time point. After the 
series is collected, the next column is 
acquired.

All selected wells Every well selected for acquisition is 
acquired at each time point. The well 
selection is determined at the start of the 
first acquisition. This option is suitable for 
a long time-lapse assay.

Note: No warning is given if the acquisition time is longer than 
the specified interval. Under these circumstances, the actual 
duration is longer than the duration time shown in the Duration 
field.
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4. If required, in the Duration field, select the amount of time for 
the entire time series. The Duration value is the result of 
multiplying the number of timepoints by the interval.
The Number of timepoints list automatically updates as the 
Duration list is changed.

Defining Protocol Settings
In the Acquisition Loop tab, you can define the protocol for your 
experiment. Use this tab to configure the following settings:

• Number of scans to perform
• Beam splitter position
• Active emission filter set
• Available lasers and laser power settings (the beam splitter 

position determines which lasers are available for selection)
• Available PMTs and PMT gain settings
• Pinhole diameter
• Activation of shading correction during acquisition

Generating Shading Correction Files
A shading correction file is required for each laser, filter, and objective 
combination. The following table details the optimal combination for 
lasers and filters.

Note: If timelapse imaging is enabled, additional options for 
autofocus are available on the Autofocus tab. See Configuring 
Laser Autofocus on page 118. Collection of specific scans at 
different timepoints can be configured on the tab for the scan of 
interest.

Table6-4 Shading Correction File Filter and Laser Combinations

Filter Beam splitter Laser Plate

DAPI Quad 405 Green

FITC Quad 488 Pink

GFP Dual 488 Pink

Cy3 Quad 532 Pink

Texas Red Quad 561 Pink

DRAQ5 Dual 635 Chroma Blue slide

Cy5 Quad 635 Chroma Blue slide
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To generate a shading correction file

1. In the MetaXpress Software, click Acquire > Acquire from 
ImageXpress Ultra.

2. In the Acquire from ImageXpress Ultra dialog, click Calibrate or 
Calibrate Galvo (depending on the MetaXpress Software version 
that you have installed).

3. Open the top door, insert the required plate (or slide placed in 
the metal slide holder) into the IXU plate holder and then select 
the appropriate objective. If the objective has a correction collar, 
set this to the lowest possible value. See Shading Correction File 
Filter and Laser Combinations on page 105.

Note: The shading correction file will only work with images that have 
an equal or shorter scan length. If the scan length is longer than 2000, 
create the shading correction file with the appropriate scan length.
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4. Click Screening > Plate Acquisition Setup. 

5. In the Plate Acquisition Setup dialog, click the Acquisition Loop tab, 
and then select the beam splitter and emission filter set.
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6. In the Pinhole Diameter section, in the Customize field, select 
1 mm.

7. Click the Autofocus tab and then click View Focusing Details. 
8. In the View Focusing Details dialog, look up the value after Plate 

Reference Point. Calculate the Z value using:
Plate Reference Point – 3000 = Z value.

9. In the Focus dialog, click Devices > Focus.
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10. In the Current Position dialog, type the Z value calculated in the 
previous step.

11. In the Plate Acquisition Setup dialog, in the Autofocus tab, click 
Configure Laser Settings. 

12. In the Configure Laser Autofocus Settings dialog, in the Preview 
Pass section, select Start from current position and then click 
Preview Pass.

13. If there is no peak, in Focus dialog, increase the value by 2000 
higher than the value calculated and repeat steps 9 to 12. If 
there is still no peak, increase the value again by 2000 and 
repeat. If there is still no peak make sure that the plate is still 
positioned correctly in the instrument.
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14. When you see a peak, or two peaks, in the Preview Pass dialog, 
click the trace line at the top of the green line of the first peak. 
The X value information is located in the bottom left as 
highlighted in the screen shot. This is the Z position of the 
bottom plate. In the example, the current Z position value is 
9172.8.

15. Click Devices > Focus and in the Focus dialog, type the Z-position 
value (rounded off) that was calculated in the previous step.

16. Click Acquire > Acquire from ImageXpress Ultra.
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17. In the Acquire from ImageXpress Ultra dialog, edit the fields:

18. In the Excitation laser power and Wavelength collection sections, 
select the required laser power and wavelength.

19. Click Acquire and adjust the laser power and PMT gain to get an 
image around 75% saturation with a 16-bit scale. 

Table6-5 Acquisition settings

Field Value

Scan Destination section Single wavelength

Number of Averages 8

Binning 1

Scan Length 2000

Tip! Start the laser at 10% and the PMT at 650. If required, 
lower the PMT or increase the percentage of laser power.
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20. Close the acquired images without saving.
21. In the Acquire from ImageXpress Ultra dialog, in the Scan 

Destination section, click Stack.

22. Click Screening > Plate Acquisition Setup.
23. In the Plate Acquisition Setup dialog, click the Plate tab and select 

the 96 well plate.
24. Click the Wells to visit tab and then right click well D05.
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25. In the Acquire from ImageXpress Ultra dialog, click Acquire.
26. Repeat steps 23 and 24 for wells D06, D07, D08, E05, E06, E07 

and E08. 
27. Click Process > Stack Arithmetic.

28. In the Stack Arithmetic dialog, select the stack name (same as 
the Scan destination name in the Acquire from ImageXpress Ultra 
dialog).

29. In the Operation section, click Average and then click Apply.
30. Click the image (same name as Result image in the Stack 

Arithmetic dialog). 
31. Click File > Save As and navigate to the C:\MX5\Shading 

directory. You can store the file in a different directory.
32. Use the following format to name the file: 

Shading_Objective_Laser_Filter.tif. 
For example, if the objective and camera is named 20X ELWD 
and the laser selected is 405, then the image name should be 
Shading_20X_ELWD_405_dapi.tif. 

33. Close the image.
34. If required, change the objective and laser and repeat the 

procedure starting at step 3.

Note: The shading image is dependent on 
laser/PMT/objective/filters/beamsplitter/pinhole/beam 
expander settings so it is best practice to acquire images with 
the same configuration as your experiment. If the shading 
image is smaller than your acquired image, then the shading 
will not work properly and you will need to acquire new shading 
images. 
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PMT Gain Overview
You can select separate gain values for each PMT. Increasing the PMT 
gain yields a brighter image, but also results in more background noise. 
The typical operational voltage range for PMTs is between 300 and 
750 V. Avoid using voltages outside this range:

• If you use less than 300 V and still have a very bright signal 
(partial saturation), your fluorescent/reflected light is too bright 
and you are permanently damaging the PMTs photocathode. 
Reduce the illumination intensity (laser power). You can further 
reduce the illumination intensity by 5 or 10 times by switching 
to one of the neutral density beam splitters.

• Voltages above 750 V do not damage the PMT but are not 
recommended. Increasing the PMT gain in this range increases 
the signal amplitude, but it also increases the noise and so does 
not improve the signal-to-noise ratio. Increase the illumination 
intensity (if the laser power is still below dye saturation level), 
or increase averaging. Signal intensity averaging is a common 
way to improve signal-to-noise ratio.
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To configure the protocol settings

1. In the Number of scans field, select the total number of 
sequential scans to perform at a single stage location. Eight is 
the maximum number of scans.
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2. In the Beam splitter field, select the beam splitter to use to 
determine which Excitation lasers are available for the 
acquisition. Select a beam splitter based on the combination of 
wavelengths you require. 

3. In the Emission filters field, select the filter cube to use. This 
setting determines which emission filters are used with each 
PMT in the Wavelength collection fields.

4. In the Excitation lasers field, select the lasers to use and adjust 
the power between 10% and 100%. To set the illumination level 
below 10%, use higher laser power and the 80/20 or 90/10 
beam splitter. To reduce the amount of sample damage from 
laser illumination (photobleaching and/or phototoxicity), 
maintain the laser power levels below 50% with the quad and 
dual beam splitters. If the images are dim, adjust the PMT gain 
prior to increasing the laser power. It is highly recommended to 
start with a setting of 10% power and only increase if required.

Table6-6 Beam splitter options

Beam splitter Description

Quad 405/488/532/635 Reflects 405 nm, 488 nm, 532 nm, and 
635 nm to the sample. Transmits spectral 
bands between these lines and above 
635 nm from the sample to the detector.

Quad 405/488/561/635 Reflects 405 nm, 488 nm, 561 nm, and 
635 nm to the sample. Transmits spectral 
bands between these lines and above 
635 nm from the sample to the detector.

Dual Reflects 488 nm and 635 nm to the sample 
and transmits between these wavelengths 
and above 635 nm from the sample to the 
detector. This is optimized for GFP and 
DRAQ5.

80/20 Transmits 80% of light and reflects 20%. 
This is flexible but not efficient for 
illumination.

90/10 Transmits 90% of light and reflects 10%. 
This is flexible but not efficient for 
illumination.
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5. In the Wavelength collection section, select the PMT check boxes 
to use and adjust the gain for each PMT if required. It is highly 
recommended to maintain the PMT gain at or below 750. Higher 
PMT gain settings result in excessively noisy images. You can 
select separate gain values for each PMT. Increasing the PMT 
gain yields a brighter image but also results in more background 
noise.

6. In the Pinhole diameter section, click Customize to use a custom 
pinhole diameter and then type a value (millimeters). This 
controls the amount of collected fluorescence that is transmitted 
to the detectors. Smaller pinhole diameters produce better axial 
resolution (optical sectioning) at the expense of lower light 
collection efficiency.

7. Select the Perform shading correction check box to enable 
shading correction.
Correction images must exist for each wavelength used to apply 
shading correction during acquisition. The shading correction file 
used for each wavelength is selected in the Scan tabs. The 
ImageXpress Ultra System has a pre-defined set of shading 
correction files available.

Note: The shot noise from the laser is a larger contributor to 
noise than the dark noise in the PMT, and it increases with the 
square root of the laser intensity. The signal-to-noise ratio, 
however, is not significantly affected by the PMT gain. 
Therefore, when you start an experiment, set the laser power to 
10% and the PMT gain to 700. If the image is saturated, turn 
the PMT down. If the image is not bright enough (though 
focused), then turn the laser up.

Note: Shading is an artifact intrinsic to all imaging systems that 
can come from the objective or other optics. Shading should be 
addressed in the hardware first, and if no hardware issues exist 
then, subsequently by using the available shading correction 
within the software. The system has been aligned to minimize 
shading artifacts but minor shading will still result from the 
intrinsic property of the optical components.
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Configuring Autofocus Settings 
You can configure the autofocus settings using a combination of three 
different tabs in the Plate Acquisition Setup dialog and in additional 
dialogs within the MetaXpress Software. Your system administrator 
must define certain autofocus settings in advance to simplify the daily 
autofocus procedures required when setting up an experiment. 

Use the following tabs and dialogs to configure autofocus:
• Plate Acquisition Setup dialog

Acquisition Loop tab
Autofocus tab
Scan tab

• Laser Autofocus Wizard on the Plate tab
• Focus dialog (optional)

Focus tab (optional)
Autofocus tab (optional)

• Configure Laser Autofocus dialog (optional)

Configuring Laser Autofocus 
After the laser autofocus settings have been completed correctly, they 
typically do not need to be modified. 

To configure laser autofocus 

1. In the MetaXpress Software, click Screening > Plate Acquisition 
Setup. 

2. In the Plate Acquisition Setup dialog, click the Wells to Visit tab.

3. Right-click on the well to use to set up and verify the focus 
accuracy.

4. Click the Autofocus tab and in the Site Autofocus section, if sites 
are enabled on the Sites tab, select the site pattern to use:

First site only—Autofocuses in the top left site in the well.
Center of well only—Autofocuses in the center of the well.
All sites—Autofocuses for each site.

Note: For closely-spaced sites and lower magnifications, it is 
best practice to focus once per well to save time. For higher 
magnifications or sites that are spaced farther apart, it is best 
practice to focus on all sites. 
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5. In the Timelapse Autofocus section, if timelapse acquisition is 
enabled on the Timelapse tab, choose the focusing pattern to 
use.

First timepoint only—Autofocuses prior to acquisition at the 
first timepoint. Subsequent timepoints are acquired at the 
same Z position. This is useful for fast kinetic responses.
All timepoints—Autofocuses prior to acquisition at every 
timepoint. This is recommended for longer timelapse 
experiments.
Every Nth timepoint—Autofocuses at the specified timepoint 
interval.

6. In the Laser-based Focusing section, in the Well to well 
autofocus field, select Focus on plate bottom only, then offset by 
bottom thickness to focus only on the bottom of the plate and 
then use the bottom thickness value to focus on your sample. 
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7. In the Laser-based Focusing section, in the Well to well 
autofocus field, select Focus on plate and well bottom if you are 
using thin-bottom plates. With this option, the autofocus always 
searches for both peaks in every well. This is recommended if 
the plate bottom variation is at least half the thickness of the 
plate bottom. 

8. On the Autofocus tab, click Configure Laser Settings to confirm the 
settings that will be used for autofocusing, including exposure 
times. If you need to change the exposure values, on the Plate 
tab, click Laser Autofocus Wizard and follow the steps that 
the wizard provides for measuring exposure times. Additional 
information about the settings that the wizard calculates is 
available in the online help, in the topic “Configure Laser 
Autofocus Settings - Dialog Box Options.”

9. On the Autofocus tab, click View Focusing Details to view all the 
settings that will be applied to your autofocus procedures. 

Note: This option offsets the focus by the bottom thickness of 
the plate as defined in the Plate tab and is suitable for lower 
magnification objectives and slides. Select this option if you are 
using a uniform thickness glass-bottom plate and a liquid 
medium. The focus is performed with the strong bottom surface 
reflection and then the high precision Z stage is used to offset 
the focus for the plate bottom thickness.

Note: This operation mode is slower but ensures more accurate 
focusing on warped plates.

Note: The Laser Autofocus Wizard calculates measurements as 
accurately as possible. Some manual verification and 
adjustment of the settings may be necessary to optimize the 
results.
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Configuring Scans
Use the Scan tabs to configure the lasers and illumination to use for 
each scan. The total number of Scan tabs depends on the number of 
scans selected in the Acquisition Loop tab. 

To configure the lasers for each scan

1. In the Plate Acquisition Setup dialog, click the Scans tab and in 
the Number of averages/line field, click the number of times to 
scan each line. Increasing this value can improve results for 
samples with low fluorescence but increases the total acquisition 
time. See Scan Lines and Averaging Overview on page 89.

2. In the Excitation lasers section, select which lasers to use for the 
scan. 
The lasers available are determined by what is selected in the 
Beam splitter and Excitation lasers fields of the Acquisition Loop 
tab. 
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3. In the Wavelength collection section, select the filter and PMT 
combinations to use for the scan. 
The filters available are determined by what is selected in both 
the Emission filters and Wavelength collection fields of the 
Acquisition Loop tab. 

4. Optionally, in the Autofocus options section, in the Offset field, 
adjust the Z offset used during autofocusing. To use the 
Calculate Offset feature, which automatically determines the 
appropriate Z motor offset distance for each scan as defined on 
the Plate Acquisition Setup tab, follow Steps 5-12. 
For the first Scan tab, the offset is the distance between the 
bottom of the well and the in-focus plane. For the second and 
subsequent Scan tabs, the offset is the difference between the 
focus position of the Z motor using the first scan and the focus 
position of the Z motor using the second or subsequent scan. As 
a simple example, suppose the position of the Z motor when the 
sample is in focus using Scan 1 is 500 and the position of the Z 
motor when the sample is in focus using Scan 2 is 700. The 
difference between the two positions is 200, so the offset for 
Scan 2 is 200. 
Before using the Calculate Offset feature:

Configure the plate parameters using all of the tabs above 
the Acquisition Loop tab.
Configure all laser autofocus parameters using either the 
Laser Autofocus Wizard (available from the Plate tab) or the 
Configure Laser Autofocus Settings dialog (available from 
the Autofocus tab). 
Ensure that the signal/noise is set so that the system can 
focus appropriately (adjust the exposure time if necessary to 
correct a dim or saturated signal).

5. On the first Scan tab, in the Autofocus options section, select 
Laser with z-offset.
The default range and step size that will be used to calculate the 
offset is based on the selected magnification setting. For 
example:
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The software uses the range and step size to determine the 
number of planes to acquire (the number of planes acquired is 
equal to approximately the range divided by the step size).

6. Optionally, to acquire fewer or more planes than the default 
number of planes (25), select the Custom Range check box 
and type new values for the range and step size of the Z stack. 
You can acquire as many planes as needed.

7. Click Calculate Offset.
The MetaXpress software acquires a Z stack of images and 
displays the following message:

8. Use the slider at the top of the Z stack image window to 
navigate to the most in-focus image. For example:

9. With the most in-focus image displayed, click OK.
The software calculates the offset and a message appears:
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The offset can be a negative value.
10. To replace the current offset with the newly calculated offset, 

click Yes.
11. Optionally, to save the Z stack, click File>Save As.

12. On the second and subsequent Scan tabs, in the Autofocus 
options section, select Z-offset from W1 and repeat Steps 6-
11.

13. If you specified multiple timepoints in the Timelapse tab, set the 
image collection intervals to use for each wavelength. 

Tip! The Test Settings button focuses on the sample and snaps 
an image using the current settings for the selected wavelength.

Table6-7 Image Collection Intervals

Option Description

All timepoints Acquires an image for each timepoint for this 
wavelength.

At start Acquires an image at this wavelength for the 
first timepoint only.

At start and end Acquires images at this wavelength for the 
first and last timepoints only.

Every nth timepoint Acquires an image at this wavelength at the 
selected timepoint interval beginning at the 
first timepoint.
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Running Journals During Acquisition
Use the Journals tab to configure specific journals to run during 
different stages of acquisition. 

To configure running journals during acquisition

1. In the Plate Acquisition Setup dialog, click the Journals tab.

Note: If you do not need to run any journals during the acquisition, 
click Next to move to the next tab.
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2. Select the check box next to an acquisition step to run a journal. 

3. Click the folder icon next to the selected acquisition step. 
The Select Screen Acquisition Journal dialog opens with the 
contents of the Journals folder displayed by default.

4. Select the journal to run at the selected acquisition step and 
then click Open. 

Table6-8 Acquisition Steps to Run Journals

Acquisition Steps Description

Before each image Runs only during the acquisition loop, after 
the illumination is set and focusing is done.

After each image Runs only during the acquisition loop, after 
scanning is complete and before images are 
saved.

Before focusing Runs only during the acquisition loop, before 
focus evaluation begins.

Start of site Runs only during the acquisition loop, before 
any images are acquired from each site.

End of site Runs only during the acquisition loop, after all 
images have been acquired from each site.

Start of well Runs only during the acquisition loop, at the 
beginning of each well, before any images are 
acquired from a well.

End of well Runs only during the acquisition loop, at the 
end of each well, after all images have been 
acquired from a well.

Start of timepoint Runs only during the acquisition loop, at the 
beginning of each timepoint, before any 
images are acquired for a timepoint.

End of timepoint Runs only during the acquisition loop, at the 
end of each timepoint, after all images have 
been acquired for a timepoint.

Start of plate Runs after the stage is moved to the find 
sample position, but before the find sample 
action is performed.

End of plate Runs after the last acquisition for a plate is 
complete.

Note: If the journal is not located in the Journals folder, navigate 
to the folder where it is located, select it and then click Open.
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5. Repeat steps 1 to 3 as required to assign journals to run at 
additional acquisition points.

6. If any of the journals you run move hardware (for example, 
change Z position), select Prevent asynchronous hardware moves. 
The journals run correctly but slow down acquisition.

Configuring the Display Settings 
You can configure the MetaXpress Software desktop appearance during 
acquisition. You can choose to use the default display settings or create 
custom settings. The pre-defined display settings tile and autoscale all 
acquired images, and make sure that the status dialog is unobstructed.
 C

Note: If you do not need to change the display settings, make sure 
that Use default display settings is selected and then click Next to 
move to the next tab. Changing the display does not change the saved 
data.
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To change the default display settings

1. In the Plate Acquisition Setup dialog, click the Display Settings tab 
and then click Manually set image display properties.

2. Click Display Images. 
The Screening Status dialog opens and an image is acquired for 
each configured wavelength.
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3. Change the configuration of the display by arranging the image 
windows and dialogs. You can change the location, size, zoom, 
scaling, gamma, and LUT of images. These new settings are 
saved and used during acquisition.

Selecting a Data Analysis Method
You can choose a specific analysis to run on a data set after the 
acquisition is complete. The data set is added to the Auto Run queue for 
analysis by an offline computer system running the MetaXpress 
Software set to Auto Run mode. You can select from a list of saved 
settings from any application modules or journal assays saved to the 
database.
The list of available assays and settings is the same list that is in the 
Assay tab of the Review Plate Data dialog.

Note: The Display images during autofocus option shows images 
during image autofocus. The ImageXpress Ultra System does 
not use image autofocus so this option does not affect the 
display properties.

Note: If you do not want to automatically run post-acquisition analysis, 
make sure that the Auto Run analysis check box is not selected and 
click Next to move to the next tab.
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To select an analysis method to automatically run after 
acquisition

1. In the Plate Acquisition Setup dialog, click the Post Acquisition tab 
and then select the Auto Run analysis check box.

2. In the Analysis list, select the assay (Application module or 
Journal Assay) to run after acquisition.

3. In the Setting list, select a settings file. 
The field below the Setting list displays a description of the 
settings if one exists.

4. You can configure and save settings in the Review Plate Data 
dialog.
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Reviewing the Plate Acquisition Settings
After you have completed all the steps to set up the plate acquisition, 
you can review a list of all current settings for the acquisition, save the 
settings to a file, and start acquiring images. 
The information in the Summary tab is identical to the information 
displayed when you click the Summary button at the bottom of the 
dialog.
Use the Plate Acquisition and Control dialog or the Plate Acquisition 
toolbar to change the stage or Z position, or snap an image to test the 
current settings before starting the acquisition.
If an error dialog opens after you click Acquire Plate, the most likely 
cause is a configuration error. Read the text in the dialog to determine 
the error.
After your acquisition is complete and the images have been saved to 
the database, you can use the Review Plate Data dialog to view the 
images and set up analysis.
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To review the plate acquisition settings file and start 
acquisition

1. In the Plate Acquisition Setup dialog, click the Summary tab and 
then click Save Settings.

2. In the Save Plate Acquisition Settings dialog, save the current 
settings to a file on the local hard drive or to the database.

3. Click Print to open the Print Setup dialog and then print the 
settings summary.

4. In the Summary tab, click Acquire Plate to acquire images from a 
plate based on the settings completed in the Plate Acquisition 
Setup dialog.

5. The Plate Acquisition Setup dialog closes and the Screen Status 
dialog opens.
Each image appears briefly on the MetaXpress Software desktop 
as it is acquired and saved to the database.
After the last image is acquired and saved, the Screen Status 
dialog closes and the Plate Acquisition Setup dialog opens.

6. In the Plate Acquisition Setup dialog, click Close.
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Saving Acquisition Settings
After you configure the plate acquisition, save the settings in the Plate 
Acquisition Setup dialog so that they can be reused. You can save the 
acquisition settings to a file on a local or network drive or to the 
database.

To save the current plate acquisition settings 

1. In the MetaXpress Software, click Screening and then one of the 
following:

Plate Acquisition and Control
Plate Acquisition
Plate Acquisition Setup

2. Depending on your selection, in the dialog that appears, click 
Save Settings. 

3. In the Save Acquisition Setting dialog, select the Save to file rather 
than database check box to save the settings file on the local 
computer.

4. Click Save and in the Screen Acquisition Settings dialog, in the File 
name field, type the name of a new settings file or select a listed 
settings file name to overwrite an existing settings file and then 
click Save.
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5. In the Save Acquisition Setting dialog, clear the Save to file rather 
than database check box to save the settings file to the 
database. 

6. In the Setting Name field, type the name of the new settings file 
or select a listed settings file from the Stored Settings field to 
overwrite an existing settings file in the database and then click 
Save.

Note: It is recommended to save to files rather than a database 
for a system that has multiple users as it is easier to organize 
settings files. Saving to files is required for running specific 
settings with a plate-loading robot.
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7
Maintenance
This chapter contains information and procedures on how to maintain 
the ImageXpress® Ultra System. It includes:

• User Safety Instructions on page 135
• Filter Cubes on page 135
• Objectives on page 140
• Configuring Objective Offsets and Parfocality on page 145
• Cleaning the ImageXpress Ultra System on page 168

User Safety Instructions
It is important to strictly observe the following safety information to 
avoid personal injury or damage to your equipment during user service 
and maintenance:

• Close the MetaXpress Software.
• Make sure that the power supply for the ImageXpress Ultra 

System is turned off and the power cable is unplugged. 
• Disconnect the USB connection to the hardware server (host) 

PC, and turn off any attached peripherals, such as the robot 
plate-loading arm.

• Access only the user-serviceable components inside the 
enclosure. Avoid contact with other components as they can be 
damaged or knocked out of alignment. 

• Keep liquids, vapor, and dust away from the interior of the 
instrument. Do not attempt to clean inside the enclosure.

• Do not leave the interlocked access panels open for extended 
periods of time.

• Make sure all components and access panels are replaced before 
restarting the instrument.

Filter Cubes
If you replace or add to any of the optical components in the factory-
standard ImageXpress Ultra System, you must:

• Change the component within the instrument.
• Update the software to reflect the new hardware configuration.
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Changing Filter Cubes
The filter cubes in the ImageXpress Ultra System are mounted in racks 
in a three-position slider within the instrument enclosure. Each rack 
holds up to three filter cubes. Filter cubes and the optical components 
they hold are delicate components, and special care is required when 
handling them. 

CAUTION! Wear powder-free gloves when you change the filter cubes to 
prevent skin oils from damaging the optical coatings. Do not touch the 
optical coatings.

To change the filter cubes

1. Click Start > Programs > MetaXpress > Meta Imaging Series 
Administrator.

2. In the Meta Imaging Series Administrator dialog that appears, in 
the List of Groups field, select MetaXpress and then click Configure 
Hardware.

3. Click Configure Devices and then click ImageXpress Ultra Filter 
Cube Changer.

4. Click Settings.
5. Click Eject Filter Cubes for the desired filter cube rack.

WARNING! Before you access the emission filter changer 
compartment, turn off the ImageXpress Ultra System.
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6. Close the Meta Imaging Series Administrator software.
7. Turn off the ImageXpress Ultra System instrument at the main 

power switch, located on the external power supply.
8. Lift the small panel up to access the filter cube changer. The 

panel is located on the side of the instrument.

Figure 7-1 ImageXpress Ultra System filter door

9. Slide out the desired filter cube rack cassette. 
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There might be some slight resistance.

10. Remove the filter cube cassette.

Figure 7-2 ImageXpress Ultra System filter cube cassette 
(below)

Figure 7-3 ImageXpress Ultra System filter cube cassette (side 
view)

11. Slightly tilt the filter cube to lift it over the raised edge of the 
filter cube cassette, and pull it out to remove it.

Note: Filter cube rack 1 is the furthest one on the left.
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12. Slide the new filter cube into place, tilting it to insert it. Check 
the orientation of the cube matches the others to make sure 
that it is firmly seated.

13. Carefully line up the filter cube cassette with the changer and 
then push the filter cube cassette back into place until the latch 
engages. 

CAUTION! Do not continue if you feel resistance while replacing the 
filter cube cassette. Remove and check it to make sure that it is lined 
up correctly with the changer.

14. Turn on the instrument at the main power switch located on the 
external power supply.

15. Click Start > Programs > MetaXpress > Meta Imaging Series 
Administrator.

16. In the Meta Imaging Series Administrator dialog, click Configure 
Hardware and then click Configure Devices.

17. In the User Settings Hardware Configuration dialog, click 
ImageXpress Ultra Filter Cube and then click Settings.

18. Click Load Filter Cubes.

19. Specify the label for the new filter cube (for example, 
DAPI;FITC;Cy3;Cy5). The position on the left is position 1. 
Separate each channel with a semicolon.

20. Click OK in all open dialog and then close the Meta Imaging Series 
Administrator dialog.

Tip! For additional information about any of the dialogs in the 
Meta Imaging Series Administrator, press the F1 key to access 
Help.

WARNING! Do not open the filter cube access door while 
the system is powered on.

Note: The format for the filter names is 
Wavelength1;Wavelength2;Wavelength3;Wavelength4. Each 
entry must be separated by a semicolon. If a filter cube is 
missing from any filter cube assemblies, leave it blank between 
the semicolons.
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21. Start the MetaXpress Software.
22. Click Devices > Configure Illumination.
23. Remove the old setting and create a new setting. Make sure that 

both the correct filter cube position as well as the correct main 
beam splitter have been selected. See To verify the filter cube 
settings on page 47.

24. Click Add/Replace to store the new setting.

Objectives
The objectives in the ImageXpress Ultra System are mounted in a four-
position linear selector. Objectives are very delicate components and 
special care is required when handling them. Make sure you review the 
safety information at the beginning of this chapter and the information 
on the correct placement of the objective. See User Safety Instructions 
on page 135 and Correct Objective Placement on page 140. 
If you add or replace any of the optical components in the factory-
standard ImageXpress Ultra System: 

• Change the component within the instrument.
• Update the software to reflect the new hardware configuration. 

Correct Objective Placement
The 10X Plan Fluor Objective must remain in position 1. It should never 
be removed. This objective is used for system calibration. 

Changing Objectives

CAUTION! Wear powder-free gloves when you change the objectives to 
prevent skin oils from damaging the optical coatings. 

Note: To configure objectives you must perform offset and parfocality 
procedures. See Configuring Objective Offsets and Parfocality on 
page 145.
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To change objectives

1. Click Start > Programs > MetaXpress > Meta Imaging Series 
Administrator.

2. In the Meta Imaging Series Administrator dialog that appears, in 
the List of Groups field, select MetaXpress and then click Configure 
Hardware.

3. Select the desired hardware configuration (can be Default) and 
then click Configure Devices.

4. In the User Settings for hardware configuration dialog, click 
ImageXpress Ultra Objectives and then click Settings.

5. In the ImageXpress Ultra Objective Settings dialog, click the Param 
Group #3 tab and then click Open Door.

6. Click the Param Group #2 tab and then click Move to Objective # 
eject position to match the objective position of your choice. 
The objective holder and stage move so that you can access the 
objective (positions 1, 2 on one side of the stage; positions 3, 4 
on the other side of the stage). 

Note: The objectives are in numbered positions and must match 
the settings in the software.
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7. Pull the objective up to engage the objective-holding device.

Figure 7-4 ImageXpress Ultra System objective changer with raised 
objective

8. Loosen and remove the objective.
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9. Replace the objective with the correction collar correctly set (if 
applicable).

10. In the Meta Imaging Series Administrator dialog, click OK.
11. In the ImageXpress Ultra Objective Settings dialog, click the Param 

Group #3 tab and then click Close Door. 
12. In the Objective Labels section, type the name of the new 

objective in the correct position. 

13. In the Refraction Medium/Index field, select the appropriate 
medium (for example, Air or Oil). 

14. In Num. Aperture field, type the numerical aperture of the new 
objective, located on the barrel of the objective.

15. Click OK in all open dialogs and then click OK to close the Meta 
Imaging Series Administrator dialog.

16. Open the MetaXpress Software.
17. Click Devices > Configure Magnification.

Note: The objective name must begin with a number, for 
example, 40X Plan Apo.
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18. In the Configure Magnification dialog, in the Name field, type the 
name of the new objective.

19. Select the ImageXpress Ultra Objective, Beam Expander, and 
Pinhole check boxes. 

20. Select the default values. See Appendix A: Objectives 
Compatible with the ImageXpress Ultra System on page 173.

21. Remove the magnification setting that you replaced.
22. In the MetaXpress Software window, click Measure > Calibrate 

Distances.
23. In the Calibrate Distances dialog, click the Setup tab.
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24. In the Define Calibrations By section, in the Units/Pixel fields, type 
the calibration for the new objective. For the calibration values, 
see Appendix A: Objectives Compatible with the ImageXpress 
Ultra System on page 173.

25. Set up laser autofocus for your plates using the information in 
Chapter 7.

Configuring Objective Offsets and Parfocality 
The purpose of the following procedure is to center on and focus each 
objective on an asymmetrical feature provided by the GP-2 slide, noting 
the X, Y, and Z positions for each objective. These values are then 
entered into the software and used to compensate for XY and Z offsets 
inherent in the opto-mechanical positioning of the objectives.
Correctly setting objective XY offset and parfocality (Z offset) values 
enables you to switch objectives in the MetaXpress Software while 
maintaining the same region of interest and focal plane on the sample. 
Setting the XY offset between different objectives enables you to 
maintain the same point of interest on a sample when objectives are 
changed from one magnification to another. Setting parfocality (Z 
offsets) between different objectives enables you to maintain the same 
focal point on a sample when objectives are changed from one 
magnification to another. 

To configure the objective offset and parfocality

1. Open the MetaXpress Software. 

2. Open the top door. 
3. Insert the GP-2 slide into the slide holder. Place the GP-2 target 

areas toward the calibration corner cut-out with the reflective 
surface facing down.

Note: The objectives must be installed and correctly configured 
in the Meta Imaging Series Administrator.
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4. Insert the slide holder into the plate holder. Place the slide 
holder with the corner cut-out towards the plate clamp.

5. Click Devices > Stage > Move Stage to Absolute Position.
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6. With the top door open, in the Move Stage to Absolute Position 
dialog, in the Current Position section, edit the values in the X 
and Y fields to move the stage so that a well-defined small 
feature is in the field of view of the 10X Plan Fluor objective. 

The estimated value for the X field is 47000 and the Y field is 
40000. 

Use the up and down arrows to center the GP-2 target above 
the 10X objective. Increasing the X position moves the stage 
to the right and decreasing the X position moves the stage to 
the left. 
Increasing the Y position moves the stage towards the front 
of the system (filter cube changer door), and decreasing the 
Y position moves the stage towards the back of the system. 
In the Move Increment section, select Custom to vary the 
movement sizes and then in the Custom Increment field, 
type the desired number (1000 is the recommended starting 
value) of microns to move. 
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7. When the centre GP-2 target pattern is above the 10X objective, 
in the Move Stage to Absolute Position dialog, click Memorize to 
return to this exact XY stage position after you close the door. 
Multiple XY coordinates can be memorized and will remain 
available as long as the MetaXpress Software is not closed.

8. In the Memorize Position dialog, in the Description field, type GP-2 
Slide and then click Memorize.

9. Close the top door.
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10. In the Move Stage to Absolute Position dialog, click Memory List 
and highlight the position memorized (GP-2 Slide).

11. In the Stage Memory List dialog, click Move to move the stage to 
the saved location and then click Save to keep memory lists for 
multiple work sections.

12. In the MetaXpress Software, click Devices > Configure 
Magnification.

13. in the Configure Magnification dialog, click Backup to back up your 
current magnification settings.
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14. In the Backup Magnification Settings dialog, in the File name field, 
type a file name and then click Save. A useful nomenclature for 
the magnification setting is IXU-XXXXXXXX-YYYYMMDD format, 
where XXXXXXX is the serial number of the IXU system you are 
backing up, YYYY is the year, MM is the month, and DD is the 
day that you are backing up the magnification setting.

15. In the Configure Magnification dialog, you must confirm the name 
of each objective you wish to define XY and parfocality settings 
on.

Click Remove to delete any unwanted magnifications.
In the Name field, type any new magnifications settings and 
then click Add and Replace to add it to a defined settings.
Select the ImageXpress Ultra Pinhole check box. The default 
pinhole value is 4.5.
For the beam expander that is appropriate for each 
objective, see Selecting a Beam Expander for an Objective 
on page 176. 

16. For this procedure, make sure that all objectives have XY offsets 
set to 0 before proceeding: 

In the Defined Settings section, double click the objective.
In the Setting section, set the X, Y Offset field to 0 and 0 and 
then click Add/Replace.
In the Configure Magnification message that appears, click 
Yes.

Note: The GP-2 slide is a chrome target layered on to glass and 
is reflective rather than fluorescent. Use the preconfigured 
Reflectance Illumination Setting (consisting of the 90-10 
beamsplitter and empty emission filter set) with a single laser 
and PMT 4 to detect the image. 
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17. A preconfigured reflectance illumination setting should be 
configured on the instrument. On the Device Control toolbar, in 
the Illum field, click Reflectance.

CAUTION! Reflective laser light can be very bright and damage your 
PMT. Make sure that the PMT is below 400 before proceeding.

18. On the Device Control toolbar, in the Mag field, select 10X Plan 
Fluor. 

19. In the MetaXpress Software, click Devices > Focus.
20. In the Focus dialog, click Configure Laser.
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21. In the Configure Laser Autofocus dialog, edit the fields:

Table7-1 Configure Laser Autofocus Settings

Field/Section Value

Action field Select Autofocus - Full Search

Search options section Select Find 1 Surface

Start position section

Start from field Type plate bottom reference position. 
This value is in the Plate Acquisition 
Setup - Autofocus dialog, in the 
Autofocus tab.

Search parameters section

Full range field 2000

Exposure 1st surface 35

Coarse step 2

Fine step 1

Laser intensity 100
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22. In the Focus dialog, click Preview Pass.
A graph window appears. If a surface is found and the exposure 
time is sufficient, a peak with overlaid red and green traces 
appears.
If no trace appears, in the Configure Laser Autofocus dialog, in 
the Start from field, increase the Z value by 500 and then in the 
Focus dialog, click Preview Pass. Repeat until a peak appears. If 
no peak appears and the Start from value exceeds 8500, 
increase the exposure time by 50 and then restart the search 
starting at the value in the Plate Bottom Reference Position field.

Note: If two reflectance peaks appear, select the left one as it 
represents the bottom surface of the slide.
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23. After a peak appears in the preview window, click the highest 
green point. The Z position of the focus position appears in the 
bottom left, as highlighted in the screen shown in step 21.

24. In the Move Stage to Absolute Position dialog, in the Current 
Position section, in the Z field, type the Z position found by 
selecting (clicking and holding the left mouse button down) the 
peak in the preview pass window. Text will appear in the bottom 
left indicating the nearest Z value.

25. Click Acquire > Acquire from ImageXpress Ultra to snap an image.
26. In the Acquire from ImageXpress Ultra dialog, edit the fields:

Table7-2 Acquisition settings

Field Value

Scan Destination Single wavelength

Number of Averages 1

Binning 2

Scan Length 2000

Excitation laser power Select the 635 check box only with 10% 
power

Wavelength collection Select PMT 4 check box only with a PMT 
gain of 200
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27. In the Acquire from ImageXpress Ultra dialog, depending on the 
MetaXpress Software version, click Calibrate or Calibrate Galvo 
and then wait until the instrument galvonometer completes 
calibration. 

28. In the Acquire from ImageXpress Ultra dialog, click Acquire.
The system produces an image that is likely out of focus.

29. In the Move Stage to Absolute Position dialog, select Custom and 
then type a value of 100. In the Current Position section, in the Z 
field, increase the value by 100.

Note: Calibration takes about 15 to 30 seconds. The cursor 
becomes an hour glass icon while the instrument calibrates and 
then returns to a cursor upon completion of the successful 
calibration.
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30. Repeat steps 27 and 28 until you obtain a sharp image.
31. To enable centering a feature with the field of view, using the 

region tool, draw a cross hairs in the image. A journal can be 
obtained from Technical Support if one is not already available 
on your instrument. The cross hairs and reference image are 
shown in the screen.

32. In the Move Stage to Absolute Position dialog, in the Current 
Position section, edit the X and Y fields to overlay the cross hairs 
with a well-defined feature as shown in the screen.

Tip! Obtain a sharp image by increasing or decreasing the 
current Z position (focus) value by using the up and down 
arrows next to the current position. 
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33. When the best focus image is displayed, record the X, Y, and Z 
positions for the 10X objective located in the Device toolbar.

34. On the Device toolbar, in the Mag field, select the next higher 
objective.
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35. Repeat steps 32 and 33 to find the XY and Z positions for each 
objective. With other objectives, you must modify certain 
parameters. 

Note: The objectives in your ImageXpress Ultra System might 
differ from the ones described in this procedure.

Table7-3 Parameter Changes for Objectives

dialog Change

Acquire from ImageXpress Ultra 
System

Increase or decrease the PMT gain to 
get an appropriate image.

Configure Laser Autofocus

Exposure 1st surface field Increase the value

Coarse step field • 10X objective—3 to 5
• 20X objective—2 to 3
• 40X objective—1 to 2
• 60X objective and higher—1 to 2

Fine step field • 10X objective—1
• 20X objective—0.5
• 40X objective—0.2 to 0.5
• 60X objective and higher—0.1 to 

0.2

Start from field Must be lower than the focal position 
of the bottom surface of the slide or 
plate. If you are unsure of an 
appropriate value, start very low and 
gradually step up until that surface 
is detected.

Full range field Must never exceed about 1.5 times 
the working distance of the objective 
you are setting. This is critical for 
short working distance objectives to 
prevent the objective from bumping 
the plate.
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36. Record the X, Y, and Z positions for all the objectives.

Entering Objective Offset and Parfocality Values
Use a spreadsheet to subtract the XY values of the 10X Plan Fluor 
objective from the values of each objective as shown in Table 7-5. The 
resulting values are entered in the X and Y offsets fields. The values in 
the table are examples only and the values you use to calculate the 
offsets might be different.

Table7-4 Objective Positions

Objective X position Y position Z position

10X Plan Fluor

20X Plan Fluor ELWD

40X Plan Apo

40X Plan Fluor ELWD

Note: The objectives listed in Table 7-4 are examples of 
objectives that can be installed in the instrument. Modify the list 
of objectives to match the ones installed in the instrument you 
are using.

Table7-5 Objective XY Offset Example Calculations

Objectives X 
Position

Y 
Position X Offset Y Offset

10X Plan Fluor 48857 43259 48857 - 48857 = 0 43259 - 43259 = 0

20X Plan Fluor ELWD 48957 43239 48857 - 48957 = 100 43259 - 43239 = 20

40X Plan Apo 48980 43309 48857 - 48980 = 123 43259 - 43309 = 50

40X Plan Fluor ELWD 48757 43289 48857 - 48757 = 
-100

43259 - 43289 = 30
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To enter objective offset and parfocality values

1. In the MetaXpress Software, click Device > Configure 
Magnification.

2. In the Configure Magnification dialog that appears, in the Defined 
Settings section, in the X and Y Offset fields, type the value you 
calculated for each objective setting and then click Add/Replace.

3. In the Configure Magnification message asking you if you want to 
replace the setting, click Yes.

4. In the Configure Magnification dialog, click Backup.

5. In the Backup All Magnification Settings dialog, in the File name 
field, edit the name using the IXUXXXXXXXX-INSTALL format 
where XXXXXXX is the serial number for the IXU system being 
backed up and then click Save.

6. Close the MetaXpress Software.
Type the parfocality (Z offset) values into the Objective Setting 
dialog in the Meta Imaging Series Administrator software.
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7. Open the Meta Imaging Series Administrator software and in the 
Enter Administrator Password dialog, in the Enter Password field, 
type the password and then click OK.

8. In the Meta Imaging Series Administrator: Single User Configuration 
dialog, click Configure Hardware.

9. In the Configure Hardware dialog, click Install System Devices.
10. In the Install System Devices dialog, in the Installed Devices 

section, click ImageXpress Ultra Objective and then click Settings.
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11. In the ImageXpress Ultra Objectives Settings dialog, in the Param 
Group #1 tab, in the Position Z Offset fields, type the values for 
each objective recorded in Step 36 on page 159. 

12. Click Normalize Offsets. 

13. Click OK to exit the ImageXpress Ultra Objectives Settings dialog 
and then click OK to exit the Install System Devices dialog. 

14. Repeat the process to add the parfocality value in the Configure 
Devices dialog.

Note: In a vacant position, use the lowest value recorded in step 
35 to enter in that position.

Note: The Z offset positions adjust and one of the four position 
offset parameters is 0.
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15. In the Configure Hardware dialog, click Configure Devices.
16. In the User Settings for X hardware configuration dialog, in the 

Claimed Devices section, click ImageXpress Ultra Objective and 
then click Settings.

17. In the ImageXpress Ultra Objectives Settings dialog, in the Param 
Group #1 tab, type the Position Z Offset values recorded for each 
objective. 

18. Click Normalize Offsets.

19. Click OK to exit the ImageXpress Ultra Objective Settings dialog 
and then click OK to exit the User Settings for X hardware 
configuration dialog.

20. Click OK to exit the Configure Hardware dialog and then click OK 
to exit the Meta Imaging Series Administrator dialog.

21. After the parfocality and XY offsets have been set and saved in 
the software, load a GP-2 slide and then focus and center on a 
position with the 10X objective. 

22. Switch objectives and without moving the stage or focus 
position, snap an image. The slide should remain relatively 
centered and in focus at different magnifications. 

Tip! For additional information about any of the dialogs in the 
Meta Imaging Series Administrator, press the F1 key to access 
the online Help for the active dialog. This includes accessing 
information on the single user and multi user modes.

Note: If a position is not being used by an objective use the 
lowest value recorded in step 35 for that position.

Note: The Z Offset Positions change from the Z positions 
recorded to the Offset values from the position 1 reference 
position. Compare these values for each position with the 
values normalized in step 11. If the resulting offset values do 
not match, double check that the values have been correctly 
recorded.
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Cleaning Objectives
If debris or contaminants have collected on an objective, you must 
clean the objective lens. You must remove the objective before cleaning 
it.

To clean the objectives

1. In the MetaXpress Software, open the instrument door. 
2. Close the MetaXpress Software and turn off the ImageXpress 

Ultra System at the main power switch located on the external 
power supply of the instrument.

3. Use compressed air to blow dust contaminants off objectives. 
Make sure you briefly purge your compressed air source before 
directing it at the objectives.

CAUTION! Do not use products that disperse aerosol propellants or fluid 
onto the lens surface. Do not invert compressed air cans as they 
disperse aerosol propellants.

4. Use lens paper and a solvent to wipe the objective free of 
contaminants. 

CAUTION! Do not use a lint-free cloth to clean the objective lens. 
Contact the Nikon objective manufacturer for the preferred cleansing 
solvent and procedure.
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Adjusting the Spherical-Aberration Correction Collar 
on Objectives
Certain Nikon objectives that are supplied with the ImageXpress Ultra 
System have adjustable correction collars, which are used to minimize 
spherical aberration in the image of the specimen. Changing this 
setting adjusts the distances between components inside the objective 
barrel. Image quality and resolution are largely dependent on properly 
setting these collars. 
The settings depend on the thickness of the microplate well or slide on 
which the specimen is mounted. In general, the correction collar should 
be set for the physical thickness of the plate or slide that you are 
imaging. Determine the physical thickness in the following ways:

• Obtaining the plate specifications from the plate manufacturer.
• Breaking a spare plate and using calipers to measure the 

thickness.
• Measuring the optical thickness with the laser autofocus and 

multiplying it by the refractive index (1.59 for polystyrene; 1.52 
for glass). 

After you have determined the thickness of your plate or slide, adjust 
the correction collar. 

To adjust the correction collar on the objectives

1. Turn on the ImageXpress Ultra System and open the MetaXpress 
Software.

2. Click Devices > Configure Magnification dialog.

3. In the Defined Settings field, double-click the magnification 
setting that you want to adjust.
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4. Click Move objective to eject position.
The top door opens and the stage and objective holder move so 
that you can access the objective.

5. Pull the objective up to engage the objective-holding device.
6. Locate the correction collar on the objective that you want to 

adjust. 

7. Rotate the correction collar to its new setting.

8. Click OK.
9. Test the correction collar setting by examining the image quality 

of the acquired images. If the quality has degraded, re-adjust 
the correction collar. The correction collars are calibrated for 
glass, so the optimum setting for polystyrene bottom plates 
might differ slightly from the actual thickness of the plate. 

Note: The graduated scale is on the barrel of the correction 
collar and shows the current setting of the objective. Use a 
flashlight to view the markings that are located on two sides of 
the objective.

Note: Some objectives are marked in mm, while others, such as 
the one shown, are marked in tens of microns.
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Using Oil-Immersion Objectives
You can use oil-immersion objectives with the ImageXpress Ultra 
System for research-mode imaging. Imaging with oil-immersion 
objectives is different from typical screening applications because you 
must keep oil between the objective and the plate. It is not possible to 
scan large areas (for example, entire slides or plates) in this 
configuration and the robustness of LAF cannot be guaranteed as the 
objective might move away from the sample during an LAF routine. 
Contact Molecular Devices Technical Support for ordering information 
for the objectives or assistance in completing this procedure.

To apply oil to the objective

1. In the MetaXpress Software, eject the plate to open the top 
door. 

2. Remove any plates in the system. 
3. Sparingly add oil to the top of the appropriate objective using a 

dropper bottle.
4. Insert the sample, either with a thin glass cover slip or in a 

microplate with a thin glass bottom (oil-immersion objectives 
are not compatible with most plastic microplates). 

5. In the MetaXpress Software, slowly step up the objective until 
you are near to focus. Oil-immersion objectives are not 
recommended for scanning entire microplates.

6. After you have completed the process with the oil-immersion 
objective, eject the plate, remove the sample, and clean the top 
of the objective with lens paper.

Note: You might need to adjust the focus settings after 
adjusting the correction collar.
0112-0149 F 167 



Maintenance
Cleaning the ImageXpress Ultra System
Clean the plate-loading region and the outside of the instrument 
without damaging the internal components of the imaging system. 
Follow these guidelines carefully to prevent damaging the instrument:

• Do not remove the front panels of instrument during the 
cleaning procedure as the panels protect the ImageXpress Ultra 
System optics and electronics. 

• Use disinfectant wipes (or lint-free cloth with 70% ethanol) to 
remove biological agents. Wipe the area with a damp wipe, 
followed by a second wipe with 100% ethanol to speed drying to 
remove non-viable biohazardous agents (carcinogens, toxins). 
With any aqueous cleaning agent, do not use too much as 
excess liquid will flow into the instrument. 

• Do not use ultraviolet light for sterilization, as this can damage 
plastic components.

• Do not use any organic solvents without first consulting 
Technical Support.

• Do not pour or squirt water or alcohol directly on to the 
instrument, to prevent damaging internal components.

CAUTION! Wear appropriate personal protective equipment as detailed 
under your company’s environmental and safety program when 
performing any cleaning procedure. 
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Robotic Plate Handling
If your ImageXpress® Ultra System has the robotic plate handler 
integrated with the base imaging system, there are additional hardware 
and user procedures to become familiar with. The robotic plate handler 
is integrated with the ImageXpress Ultra System in such a way that 
plates can be scanned for barcodes, loaded onto the imaging system 
where images are acquired and then returned to a home location. 
If at any point you would like to upgrade your system with the robotic 
plate handler, contact your Molecular Devices Sales Representative.

CRS Catalyst Express Robot Hardware
The CRS robotic plate handler can be integrated with the ImageXpress 
Ultra System. The robot step-by-step protocol is as follows: 

1. Get a microplate from a hotel shelf.
2. Scan the microplate barcode.
3. Load the microplate onto the ImageXpress Ultra System.
4. Acquire images.
5. Unload the microplate from the ImageXpress Ultra System.
6. Return the microplate to the original hotel shelf.

CRS Catalyst Express Robot User Procedures

Loading Plates onto the CRS Catalyst Express Robot
You must properly load your plates onto the hotels of the robotic plate 
handler to use the CRS Catalyst Express robot to scan barcodes and to 
load and unload plates in the ImageXpress Ultra System. If the plates 
are not loaded in the correct orientation, two errors will occur:

1. The barcode will not be scanned.
2. Well position A1 will not be correctly located in the front left 

corner of the plate-loading region on the ImageXpress Ultra 
System. 
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To prevent improper loading of plates

1. If you plan to scan barcodes, properly affix the barcode labels 
before loading plates onto the robotic plate handler. Labels are 
located on the front left side of the plate and they must be 
consistently located in the same position on all plates being 
scanned. 

2. The CRS Catalyst Express has three vertical racks (“hotels”) on 
to which you can load microplates. 

Note: Use labels with a minimum line height of no less than 7.5 
mm, preferably 10 mm. For recommendations on compatible 
barcode vendors, contact Molecular Devices Technical Support.

Note: When you are positioned in front of the robot, the hotel 
numbers (1–3) are at the front of the robot as shown in the 
photograph below.
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3. Load the plates into the hotels so that each plate is set up 
tightly against the lip of the rear of the plate holder (toward the 
robot).

.

4. If your plates are loaded with the barcode facing front and A1 in 
the front left location, then the plates will be scanned and 
correctly loaded on to the ImageXpress Ultra System plate-
loading area.

A1

Tip! When the plates are correctly placed in the hotels, the well 
position A1 is located in the front left corner as viewed from the 
front of the robot.
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A
Objectives Compatible with the 
ImageXpress Ultra System
Table A-1 details the Nikon objectives that are compatible with the 
ImageXpress® Ultra System, their properties, recommended settings 
for the beam expander, pinhole, and distance calibration. It also 
provides plate compatibility information.

Note: You can use oil objectives for research imaging but they are not 
suitable for screening applications.

TableA-1 Nikon Objectives Compatible with the ImageXpress Ultra System

Objective 
Properties Recommended Settings Plate Compatibility

Objec-
tive 
Magnifi-
cation 
and 
Type

Part #
Numer-
ical 
Aper-
ture

Work-
ing 
Distance

IXU 
Beam 
Expand-
er

IXU 
Pin-
hole 
Default

Distance 
Calibra-
tion

Cover 
Slips 
(0.17 
mm)

Thin-
bottom 
plates 
(0.17 
mm)

Thick 
bottom 
plates 
(0.25 
to 1 
mm)

4X S 
Fluor

1-
6300-
0189

0.20 15.5 mm 3x 4.5 mm 2 
µm/pixel

4X Plan 
Apo

1-
6300-
0121

0.20 15.7 mm 3x 4.5 mm 2 
µm/pixel

10X Plan 
Fluor

1-
6300-
0190

0.30 16 mm 2x 4.5 mm 0.8 
µm/pixel

10X S 
Fluor

1-
6300-
0122

0.50 1.2 mm 3x 4.5 mm 0.8 
µm/pixel

(1) 

20X 
Super 
Plan 
Fluor 
ELWD cc 
0 to 2 
mm

6500-
0108

0.45 8.1 to 7.0 
mm

2x

(2) (2)
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20X Plan 
Fluor 
ELWD cc 
0 to 2 
mm

1-
6300-
0123

0.45 8.1 to 7.0 
mm

2x 4.5 mm 0.4 
µm/pixel

(2) (2)

20X S 
Fluor

1-
6300-
0411

0.75 1 mm 2x 4.5 mm 0.4 
µm/pixel

20X Plan 
Apo

1-
6300-
0196

0.75 1 mm 2x 4.5 mm 0.4 
µm/pixel

40X 
Super 
Plan 
Fluor 
ELWD cc 
0 to 2 
mm

6500-
0109

0.60 3.7 to 2.7 
mm

(2) (2)

40X Plan 
Fluor 
ELWD cc 
0 to 2 
mm

1-
6300-
0124

0.60 3.7 to 2.7 
mm

1x 4.5 mm 0.2 
µm/pixel

(2) (2)

40X Plan 
Apo cc 
0.11 to 
0.23 mm

1-
6300-
0412

0.95 0.14 mm 2x 4.5 mm 0.2 
µm/pixel

40X S 
Fluor cc 
0.11 to 
0.23 mm

1-
6300-
0197

0.90 0.3 mm 2x 4.5 mm 0.2 
µm/pixel

40X Plan 
Fluor Oil

1-
6300-
0416

1.30 0.2 mm 2x 4.5 mm 0.2 
µm/pixel

TableA-1 Nikon Objectives Compatible with the ImageXpress Ultra System (cont’d)

Objective 
Properties Recommended Settings Plate Compatibility

Objec-
tive 
Magnifi-
cation 
and 
Type

Part #
Numer-
ical 
Aper-
ture

Work-
ing 
Distance

IXU 
Beam 
Expand-
er

IXU 
Pin-
hole 
Default

Distance 
Calibra-
tion

Cover 
Slips 
(0.17 
mm)

Thin-
bottom 
plates 
(0.17 
mm)

Thick 
bottom 
plates 
(0.25 
to 1 
mm)
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1. Using microplates thicker than 0.3 mm will result in image degradation with the 
10X S Fluor objective.

2. The 20X and 40X Plan Fluor ELWD objectives will image through cover slips and 
thin-bottom plates, but other objectives will give better resolution and higher 
light throughput. 

3. The 60X Plan Fluor ELWD objective works well with plates of 0.5 to 1.5 mm but 
is not ideal for thick bottom plates of 0.25 mm.

60X 
Super 
Plan 
Fluor 
ELWD cc 
0 to 2 
mm

6500-
0110

0.70 1.8 to 
2.62 mm

1x

(2) (2)

60X Plan 
Fluor 
ELWD cc 
0.5 to 
1.5 mm
(Obsolet
e 
Decembe
r 2008)

1-
6300-
0389 

0.70 2.1 to 1.5 
mm

1x 4.5 mm 0.133 
µm/pixel

(3)

60X Plan 
Fluor

1-
6300-
0414

0.85 0.3 mm 1x 4.5 mm 0.133 
µm/pixel

60X Plan 
Apo Oil

1-
6300-
0417

1.40 0.21 mm 1x 4.5 mm 0.133 
µm/pixel

100X 
Plan 
Fluor cc 
0.14 to 
0.20 mm

1-
6300-
0415

0.9 0.2 mm 1x 4.5 mm 0.08 
µm/pixel

100X 
Plan 
Fluor Oil

1-
6300-
0418

1.30 0.2 mm 1x 4.5 mm 0.08 
µm/pixel

TableA-1 Nikon Objectives Compatible with the ImageXpress Ultra System (cont’d)

Objective 
Properties Recommended Settings Plate Compatibility

Objec-
tive 
Magnifi-
cation 
and 
Type

Part #
Numer-
ical 
Aper-
ture

Work-
ing 
Distance

IXU 
Beam 
Expand-
er

IXU 
Pin-
hole 
Default

Distance 
Calibra-
tion

Cover 
Slips 
(0.17 
mm)

Thin-
bottom 
plates 
(0.17 
mm)

Thick 
bottom 
plates 
(0.25 
to 1 
mm)
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Selecting a Beam Expander for an Objective
You can estimate the pupil diameter of the Nikon infinite conjugate 
objectives using the formula below.
Diameter = 2 *NA* objective focal length

2 *NA* (200 mm/objective magnification)
For the 10X Plan Fluor the NA= 0.3

Diameter = 2 *0.3* (200/10) = 12 mm
For the 40X Plan Apo NA = 0.95

Diameter = 2*0.95*5mm = 9.5 mm.
Use the guidelines in Table A-2 to select the appropriate beam 
expander for an objective. The default beam expander settings set the 
excitation laser beam diameter to be comparable to or slightly smaller 
than the objective pupil diameter. This represents a compromise 
between optical efficiency and axial resolution. Select a lower 
magnification beam expander to increase optical efficiency. Select a 
higher magnification beam expander to increase axial resolution.

Note: When used with thin-bottom plates, the short working distance 
of 20X S Fluor, 20X Plan Apo, 40X S Fluor, 40X Plan Apo, 40X Plan 
Fluor Oil, 60X Plan Fluor, 60X Plan Apo, 100X Plan Fluor, and 100X Plan 
Apo objectives can cause interference with microplate skirt when 
imaging edge wells. It is recommended to either omit the edge wells 
or use a plate with a low skirt.

TableA-2 Beam Expander and Objective

Beam Expander Objective Pupil Diameter

1x Up to 9 mm

2x 9 to 15 mm

3x 15 mm and above
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B
Site Requirements
ImageXpress Ultra System Specifications
The ImageXpress® Ultra System is designed to operate indoors in 
laboratory conditions. For optimal performance, site requirements must 
be met. As with any precision optical instrument, care should be taken 
to maintain a low-dust, low-vibration environment. Temperature and 
humidity extremes can compromise performance.

Note: Contact your Molecular Devices Sales Representative or 
Technical Support for the most current version of the site requirement 
document.

TableB-1 Site Requirements

Requirement Description

Environmental Temperature 50° F to 86° F (10°C to 30°C)

Environmental Humidity 5% to 50% non-condensing

Altitude Up to 1.25 miles (2000 m)

Power Requirements The ImageXpress Ultra System can be directly 
connected to all international supply voltages. 
The input voltage range is from 
100 to 240 V~ and input frequency range 
50/60 Hz. No range switching is required. 
Fluctuations must not exceed ± 10% of the 
nominal voltage. Use the included IEC power 
cord to connect the external power supply to a 
grounded power receptacle that is rated for 15 
A. The ImageXpress Ultra System requires 
one to three outlets. If the robot option is 
purchased, two additional power outlets are 
required. If using a power strip, do not 
connect the acquisition computer to the same 
power strip as the instrument. The acquisition 
computer and monitor are not necessarily 
auto switching between input voltages.

Power Consumption ImageXpress Ultra System power 
consumption is 1100 watts for two to three 
seconds at initialization, 800 watts average 
operating RMS.
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Space Requirements Table or bench top 36 inches (91 cm) deep. 
There needs to be space below the table for 
the power supply so that the power cable can 
easily reach the back of the instrument.

Rear Clearance The rear of the instrument should be no closer 
than 6 inches (15 cm) to a wall.

Weight Requirements The table must be sufficient to support 
350 pounds (160 kg) with minimal vibration.

TableB-1 Site Requirements (cont’d)

Requirement Description
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C
Electromagnetic Compatibility (EMC)
REGULATORY INFORMATION FOR CANADA 
(ICES/NMB-001:2006)

This ISM device complies with Canadian ICES-001.
Cet appareil ISM est confomre à la norme NMB-001 du Canada.

ISM EQUIPMENT CLASSIFICATION (Group 1, Class A)
This equipment is designated as scientific equipment for laboratory use 
that intentionally generate and/or use conductively coupled radio-
frequency energy for internal functioning, and are suitable for use in all 
establishments, other than domestic and those directly connected to a 
low voltage power supply network which supply buildings used for 
domestic purposes.

INFORMATION FOR THE USER (FCC NOTICE)
This equipment has been tested and found to comply with the limits for 
non-consumer ISM equipment, pursuant to part 18 of the FCC Rules. 
These limits are designed to provide reasonable protection against 
harmful interference in a non-residential installation. This equipment 
generates, uses, and can radiate radio frequency energy and if not 
installed and used in accordance with the instructions, may cause 
harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If 
this equipment does cause harmful interference to radio or television 
reception, which can be determined by turning the equipment off and 
on, the user is encouraged to try to correct the interference by one or 
more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from 

that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for 

help.
In order to maintain compliance with FCC regulations, shielded cables 
must be used with this equipment. Operation with non-approved 
equipment or unshielded cables is likely to result in interference to 
radio and TV reception. The user is cautioned that changes and 
modifications made to the equipment without the approval of the 
manufacturer could void the user's authority to operate this equipment.
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Index
Numerics
405 nm laser

applications compatible with 
system 68

compatible dyes 68
488 nm laser

applications compatible with 
system 70

dyes compatible with system 70
532 filter set configuration, filter 
cubes 35

532 nm laser
applications compatible with 
system 72

dyes compatible with system 72
561 filter set configuration, filter 
cubes 37

561 nm laser
applications compatible with 
system 73

dyes compatible with system 73
635 nm laser

applications compatible with 
system 75

dyes compatible with system 75

A
A1 center, verifying plate reference 
point 57

acquisition settings
verifying, using Meta Imaging 
Series Administrator 50

adding
experiment information 86
pre-configured plate types 61

adjusting, correction collar on 
objectives 165

analysis methods, selecting 129
applications

405 nm laser compatible dyes 68
488 nm laser compatible dyes 70
532 nm laser compatible dyes 72
561 nm laser compatible dyes 73
635 nm laser compatible dyes 75
for experiments 68

applying, oil to objectives 167
autofocus laser, red diode 38
autofocus settings, configuring 118
averaging

binning, combined 89
plate acquisition 89

AxoTrace messages, logging 23

B
backing up

calibration settings, MetaXpress 
Software 53

magnification settings, 
MetaXpress Software 52

beam combiners
imaging optics 30

beam expander
purpose 30
selecting for objective 176
verifying settings 46

beam splitters
standard configuration 31
verifying settings 49
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Index
binning and averaging, combined 89
binning, configuring 87

C
calibration settings

backing up using MetaXpress 
Software 53

verifying in MetaXpress Software 
53

cell counting, configuring on plates 
100

changing
binning settings 89
filter cubes, maintenance 135
objectives 141
scan lines settings 89

cleaning
instrument 168
objectives 164

components
imaging optics 29
system 19

configuring
autofocus settings 118
binning settings 87
display settings, plate acquisition 
127

laser autofocus 118
lasers for scans 121
number of scan lines 87
objective offsets 145
parfocality 145
protocol settings 115
sites to visit on plate 96
wells to visit on plate 95

confirming
laser autofocus response 54
laser autofocus settings, plate 
files 62

confocal imaging 27

correction collar, adjusting on 
objectives 165

creating
experiments 83
experiments, using existing 
settings files 84

CRS Catalyst Express Robot
loading plates 169
preventing, improper loading of 
plates 170

user procedures 169

D
display settings, configuring for plate 
acquisitions 127

dyes
405 nm laser compatible with 
system 68

488 nm laser compatible with 
system 70

532 nm laser compatible with 
system 72

561 nm laser compatible with 
system 73

635 nm laser compatible with 
system 75

for experiments 68

E
electromagnetic compatibility 179
electronics, instrument 29
EMC 179
emission filters, filter cubes 33
excitation lasers

imaging optics 29
optional 30
standard 30
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experiments
adding information 86
applications 68
creating 83
creating using existing settings 
files 84

dyes 68
fluorophores 68
laser power 65
objectives, choosing 67
planning 63
sample preparation 65

F
filter cubes

532 filter set configuration 35
561 filter set configuration 37
changing 135
comparison with eipfluorescent 
filter tubes 34

emission filters 33
standard configuration 35
verifying settings 47

fluorescence imaging 27
fluorophores 68
fuses, safety information 16

G
galvanometer 30
generating, shading correction files 
105

H
hazardous material precautions 17

high voltage, safety information 16
high-content experiments, planning 
63

I
images

setting multiple timepoints 102
troubleshooting poor quality 64

ImageXpress System installation 20
imaging optics

beam combiners 30
beam splitters 31
components 29
emission filters 33
galvanometer 30
motorized iris 32
objective lenses 32
photomultipler tubes 37
relay lens 31
tube lens 32

installing, ImageXpress System 20
instrument

cleaning 168
electronics 29
features 19
non-interlocked panels 14
overview 19
protective housing 13
safety information 10
safety label 11
schematic 28

J
journals, running for plate 
acquisitions 125
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Index
L
laser autofocus

configuring 118
confirming response 54
confirming settings 62

laser focus, plate acquisition 94
laser power

experiments 65
samples, finding optimal 65

lasers
configuring for scans 121
incompatible probes 76
safety information 14

lifting hazard, safety information 17
loading plates

CRS Catalyst Express Robot 169
preventing improper loading 170

logging, AxoTrace messages 23

M
magnification settings, backing up 
using MetaXpress Software 52

maintenance
adjusting correction collar on the 
objectives 165

applying oil to objectives 167
changing objectives 141
cleaning the instrument 168
cleaning the objectives 164
filter cubes, changing 135
limitations for users 17
user safety instructions 135

Meta Imaging Series Administrator
device settings, verifying 39
verifying, acquisition settings 50

MetaXpress Software
backing up, calibration settings 
53

backing up, magnification 
settings 52

starting 22
verifying, calibration settings 53

motorized
iris 32
objective (Z) stage 37
objective changer 37

motorized X-Y stage, sample X-Y 
stage 38

moving parts, safety information 16

N
Nikon objectives, compatible with 
system 173

O
objective (Z) stage

motorized 37
motorized objective changer 37

objective lenses 32
objective offsets

configuring 145
values 159
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objectives
adjusting, correction collar 165
applying oil 167
changing 141
cleaning 164
correct placement 141
experiments, choosing 67
Nikon, compatible with system 
173

numerical aperture 67
oil immersion 167
selecting beam expander 176
verifying settings 44

oil immersion objectives 167
optical thickness 94
optimal laser power, samples 65

P
panels, non-interlocked 14
parfocality

configuring 145
values 159

Photomultiplier Tubes (PMT) 37
pinhole settings

verifying 46
placing objectives correctly 141
planning, high-content experiments 
63

plate acquisition
averaging 89
binning 87
combined binning and averaging 
89

configuring binning settings 87
configuring laser autofocus 118
configuring lasers for scans 121
configuring plates 91
configuring scan lines 87
configuring, cell counting 100
creating experiment, using 
existing settings file 84

creating experiments 83
display settings, configuring 127
experiment information 86
journals, running 125
optical thickness 94
PMT gain overview 114
protocol settings 105
reviewing settings 131
running 25
scan lines 89
screening menu, MetaXpress 
Software 80

setting multiple timepoints 102
setting up 25
shading correction images, using 
62

sites to visit, configuring 96
wells to visit, configuring 95

Plate Acquisition and Control dialog 
box, overview 81

Plate Acquisition Setup dialog box, 
overview 82

plate acquisitions
settings, saving 133
starting 132

plate clamp, sample X-Y stage 38
plate files, confirming laser 
autofocus settings 62

plate holder, sample X-Y stage 38
plate reference point, verifying A1 
center 57
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Index
plate settings files, creating 
experiments 84

plate types
adding, pre-configured 61
guidelines for selecting 77
verifying 61

plates, configuring 91
PMT gain, plate acquisition 114
PMTs, operational voltage range 114
power supply

safety label 12
power supply, voltage range 16
pre-configured plate types, adding 
61

probes
compatible with lasers 68
incompatible with lasers 76

protective housing, instrument 13
protocol settings

configuring 115
plate acquisition 105

R
red diode laser, autofocus 38
relay lens, imaging optics 31
reviewing, plate acquisition settings 
131

robot plate handling, CRS Catalyst 
Express hardware 169

S
safety information

fuses 16
hazardous material precautions 
17

high voltage 16
instrument 10
lasers 14
lifting hazard 17
moving parts 16
power supply 16

safety instructions, maintenance 
tasks 135

safety label
instrument 11
power supply 12

sample preparation, experiments 65
sample X-Y stage

motorized X-Y stage 38
plate clamp 38
plate holder 38
sample 38

samples
optimal laser power, finding 65

saving, plate acquisition settings 133
scan lines

configuring settings 87
plate acquisition 89

scans, configuring lasers 121
schematic, instrument 28
screening menu, plate acquisition 80
selecting

beam expander for objective 176
data analysis methods 129
plate types 77

setting up, plate acquisition 25
settings, plate acquisition 131
shading correction files

generating 105
verifying 62
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site requirements, system 
specifications 177

sites to visit
examples 98
plate, configuring 96

standard configuration, filter cubes 
35

starting
MetaXpress Software 22
plate acquisitions 132

system
installing 20
main connections 20
turning off 25
turning on 21

system specifications, site 
requirements 177

T
timepoints, setting to acquire 
images 102

troubleshooting
poor quality images 64

tube lens, imaging optics 32
turning off, system 25
turning on, system 21

U
user safety instructions, 
maintenance tasks 135

V
verifying

acquisition settings, Meta 
Imaging Series Administrator 50

beam expander settings 46
beam splitter settings 49
calibration settings, MetaXpress 
Software 53

device settings, Meta Imaging 
Series Administrator 39

filter cube settings 47
objective settings 44
pinhole settings 46
plate reference point, A1 center 
57

plate types 61
shading correction files 62
X Y Z settings 40

voltage range
PMTs 114
power supply 16

W
warning labels 13
wells to visit, configuring plates 95

X
X Y Z settings, verifying 40
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